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Introduction

Net3 Concert is a powerful configuration setup and monitoring application provided for users of
networked ETC systems. ETC developed the Concert application to supply our customers, both
end-users and technicians alike, a unified system configuration and monitoring application.
Concert can be used either online, connected to a networked system, or offline, without
connection to any network.

• When used online, updates to the connected system can be made in Live Edit, where
changes made to devices are real-time, or changes can be synchronized to the networked
system.

• When used offline, full system configurations can be written and uploaded when later
connected to the actual networked system.

Methodology
Net3 Concert software is a device-based configuration and management application. All devices
which have a device package available can be configured and managed through Concert.

Synchronizing and Linking Devices
Net3 Concert maintains values for all of the device properties locally on the host computer.
When Concert is running and devices are present on the network, Concert compares its local
values with the properties of the linked device on the network. If the values of the device on the
network and the values in the Concert configuration differ, then the device will display a Sync
Status icon in red, meaning it is out of sync. To synchronize the network devices and the
Concert configuration, use the provided [Synchronize Configuration] button in the toolbar, or
select " Synchronize Configuration" from the Network menu.

The association of a device in the Concert configuration with a physical device on the network is
called Linking. If a configuration is created using the "Network Map" feature, or by dragging
devices into the Workspace from Discovered Devices, the devices will be linked. If a
configuration is created using devices from the Device Library, which is a method typically done
when working offline from a networked system, when later connected to a network, you will
need to manually link to the physical network device using the "Link to Network Device"
feature.

New in Concert version 4.0.0
• Usability updates to the Spreadsheet
• Device Property Change Indication

New in Concert version 3.1.0
• Underlying changes to improve speed of startup and application responsiveness
• Ability to enable or disable RDM for an entire system
• Ability to rapidly discover RDM devices for an entire system

New in Concert version 3.0.0
• RedesignedWelcome page, tab operation and new Concert logo
• Eos and Cobalt console device detection
• Echo Relay Panel (ERP, ERP-FT), SensorIQ and EchoDIN device configuration, along with
device-specific help

• Ability to import CEM+, CEM3 and ERP configuration files from Toolsmenu
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• Ability to launch Paradigm LightDesigner and ControlDesigner applications from Tools
menu

• Ability to identify when you are running Beta release software
• Updated RDM parameter support
• Simple method of finding devices from the Browser
• Redesigned Device Operations for RDM fixtures
• Concert configuration files are now saved as .ccz files for improved file sizes

New in Concert version 2.0.2

New serial port configuration in the Gateway Configuration Editor.

New in Concert version 2.0.0
• New, more uniform icon design.
• Major performance improvements to the underlying network engine
• Progress bars per device in Component Manager when configurations are sent or
received

• Ability to sort and search lists of discovered devices or items in the Spreadsheet view
• Ability to edit, lock, align, and distribute graphical items in the Workspace view
• Ability to archive and restore CEM3 system configurations

New in Concert version 1.1.0
• New Find Unreachable Deviceswizard allows discovery of devices that are online but
unreachable by Concert.

• Enhanced properties have been enabled in Concert for supporting Gateways including:
- Runtime Properties are dynamically updated, un-editable properties displayed in the
Property Editor for supporting devices.

- Sticky IP allows Gateways to maintain an assigned IP address, even when a DHCP
server is running on the network, until deselected or manually reset using the "Reset
Dynamic IP" feature from the device context menu.

- Backlight property is now exposed in the Property Editor for supporting devices.

• New actions are available for Gateway devices that are online.
New in Concert version 1.0.4

• Support for CEM3 v1.5.0 including the following features:
- New FDX 3000 device package is available and displays as an icon in the Device
Library.

- New dimmer curves available for Sensor 3 and FDX 3000.
- New Smoothed Control Mode available for Sensor 3 and FDX 3000.
- The "Space" field has been added in the CEM3 ODS Export.

New in Concert version 1.0.3
• Workspace caption font preferences
• Your instance of Concert is identified with an icon in the Workspace
• Unsaved configuration file changes are identified in the file name
• Support for RDM Device discovery and configuration using ETCs Gadget USB to
DMX/RDM Interface
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Compatibility
Net3 Concert is currently compatible with the following ETC products:

• Response or Net3 DMX/RDM Gateways
• Sensor 3 Power Control systems
• Sensor+ Dimming Systems
• Paradigm Architectural Control Processor and Paradigm Central Control Server
• Net3 Conductor
• Net3 RFR
• IO and Show Control Gateways
• Response DALI Gateway
• Response MIDI Gateway
• Any RDM device connected to an ETC DMX/RDM Gateway or Gadget interface
• Foundry Distributed Power Control Products
• Echo Relay, EchoDIN and Sensor IQ Power Control products
• Eos and Cobalt family consoles

Operating System Requirements
Net3 Concert is installed by running the setup installer on any PC that complies with the
requirements listed below.

Minimum Personal Computer Requirements
• Windows 7 Home Premium or better, Windows 8, or Windows 10
• 2GHz (dual or quad core recommended)
• 1GB RAM (2GB or more recommended)
• Video Card capable or 1024 x 768 resolution (1280 x 1024 or higher recommended)
• Ethernet Port
• USB Port
• Keyboard and Mouse

Using this Manual
This manual is for use with Net3 Concert software version 1.1.0. The following formatted
statements are used in the Concert documentation to alert you to important information.

Note: Notes are helpful hints and information that is supplemental to the main text.

Tip: Tips are supplemental or provide use case information related to a particular
task.

VIDEO TUTORIAL: Video tutorials are viewable when using Net3 Concert online help system.

This manual has been optimized for viewing and interaction using Acrobat software.

You can browse topics using the provided Table of Contents, jump to sections using the Browser
feature, or use Search to find specific key terms throughout this document. References to other
parts of the manual are indicated in blue with underline.
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When viewing this manual electronically, click on the reference to jump to that section of the
manual. More importantly, Net3 Concert offers a built-in help system which mimics the content
that is found within this manual.

Accessing the Help System
Help system files are included in the system software ensuring they always match the software
version. Once you launch Net3 Concert software, you will have access to the help system.

To access the Net3 Concert help system select "Overview" from the Help menu. The online help
system will launch in your default browser.

Contacting ETC
For questions about product delivery, contact ETC Professional Services. For general information
about Net3 Concert, your most convenient resources are the references provided in this online
help system. To search more widely try the ETC web site at HTTP://www.etcconnect.com/.

Technical questions about Net3 Concert and its use, please contact ETC Technical Services
department directly at one of the offices listed below. Emergency service is available from all
ETC offices outside of normal business hours.

When calling for assistance, please have the following information available:

• Your location and job name.
• Version of Net3 Concert and the computer operating system used.
• A reference list of network equipment including network switches, DHCP Address server,
and interfaces.

• DMX and sACN control source, if any.

Americas United Kingdom
ETC Inc. ETC Ltd.
Technical Services Department Technical Services Department
3031 Pleasant View Road 26 - 28 Victoria Industrial Estate
Middleton, WI 53562 Victoria Road
800-775-4382 (USA, toll-free) London W3 6UU, UK
+1-608 831-4116 +44 (0)20 8896 1000
service@etcconnect.com service@etceurope.com

Asia Germany
ETC Asia, Ltd. ETC GmbH
Technical Services Department Technical Services Department
Room 1801, 18F Ohmstrasse 3
Tower I, Enterprise Square 83607, Holzkirchen, Germany
9 Sheung Yuet Road +49 (80 24) 47 00-0
Kowloon Bay, Kowloon, Hong Kong techserv-hoki@etcconnect.com

+852 2799 1220
service@etcasia.com

Please email comments about this online help content to: techcomm@etcconnect.com.

http://www.etcconnect.com/
mailto:service@etcconnect.com?subject=Americas tech service
mailto:service@etceurope.com?subject=Europe's tech service
mailto:techserv-hoki@etcconnect.com?subject=Germany tech service
mailto:service@etcasia.com?subject=Asia tech service
mailto:techcomm@etcconnect.com?subject=ETCNet3 Concert online help system
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Launch Net3 Concert Configuration

Click the Net3 Concert icon located in the Windows® task bar or navigate to <ETC>\ Net3
Concert from the Start menu.

When Concert is launched for the first time, or if the network interfaces on the host computer
have changed since the last time the application was launched, the "Select Network Interface"
dialog displays. Reference Network Interface Selection or reference Network Access for
information regarding choosing a network interface. If you are working offline, without any
network connection, click the [Work Offline] button to start Concert in offline mode.

Welcome View
Once you select your network interface, Concert is launched and the Welcome view appears.
From the Welcome view, you can either open an existing project or start a new one.

Open
From the Open section, you have the option to select recently saved projects on which you have
worked.
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Get Started
From the Get Started section, you can select one of the following options:

• Network Map - Creates a network map of you system. Reference Network Map for more
detail.

• NewProject - Allows you to start creating a new configuration by entering the project
properties. The "NewProject - Project Properties" dialog displays.

• Browse - Allows you to locate and open a configuration from a different directory or
external storage device. Browse to the directory containing your configuration file
(Concert Files have a *.ccz file suffix - .ccf for files saved in Concert version 2.x or below)
and click [Open]. The project opens to the application workspace.

• Begin Work - Allows you to start working in Concert immediately without any
configuration.

Learn More
You can learn more about Concert by following any of the links in this section.

• ViewConcert Help system - Open the Help system you are currently viewing
• Visit the ETC Website - Open etcconnect.com in a Web browser
• Visit the ETC Forums - Opens the ETC online community forums where you can read
through and respond to blog posts about various ETC products

Network Interface Selection
When Net3 Concert is launched for the first time, or if a network interface on the host computer
changed since the last time the configuration in Concert was opened, the Concert Network
Access dialog displays.

Network details are shown for each identified network interface including the IP Address,
Name, Subnet Mask, Gateway, and MAC Address.

Choose the preferred network interface for the lighting system by selecting the related check
box. This selection persists each time Concert is closed and reopened until a network interface
changes or the Network Access preference is changed.

Note: A network interface that is not physically connected or has an IP Address of
0.0.0.0 will show as "unavailable" in the selection column. This network cannot be
selected for use until it has been configured.

If you are working offline, without any network connection, click the [Work Offline] button to
start Concert in offline mode.
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Network Map
The Network Map feature automatically discovers devices on the network and draws a map
showing all of the detected devices and as much of the network infrastructure as can be
detected.

Note: After the Network Map is drawn, any new devices that are discovered will
display in the Discovered Devices dock.

The type of connection detected between the each of the devices and the network router, such
as DMX A, DMX B, Ethernet, etc., also displays as the connecting lines in the map. The
properties for the connection type are defined in the device package and added to the
preferences. Refer to the "General" tab in preferences to specify a different color for the
connection type. Connections can be edited using the [Connection] tool in the Drawing
toolbar.

From the Welcome View
From the Welcome view, click the [Network Map] button to perform the Network Map feature.
Concert will begin the discovery process, displaying the progress for verification. When the
discovery is complete, the network map displays in the World Viewof the workspace .

From the Main toolbar

From the Main toolbar, select the Network Map button. When the discovery is complete, the
network map displays in the World Viewof the workspace.
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From the File Menu

From the File menu, select "Network Map" . If a configuration is already open, a "Save
Configuration" dialog displays for confirmation to save, discard, or cancel the current
configuration. The Network Map feature cannot be performed until this dialog is resolved. After
dialog resolution, Concert begins the discovery process, displaying the progress for verification.
When the discovery is complete, the network map displays in the World Viewof the
workspace.
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Application Overview

Net3 Concert provides configuration tools and live editing of ETC networked products of all
sizes, from simple to complex.

The Net3 Concert default application view is divided into five sections including:

• Workspace or Spreadsheet views
• Property Editor
• Browser
• Error Status
• Discovered Devices / Device Library
• Notes
• Status Bar

In addition to the provided menus (File, Edit,Network, etc.), toolbars provide users quick access
to the most commonly accessed application features and settings.
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Workspace
The workspace is the central work area of the Net3 Concert application that displays the system
layout (world view and logical systems). By default, this workspace is graphical but an
alternative Spreadsheet view is available. You can have multiple workspaces open in separate
tabs at once (World View and multiple logical systems, World View and Conductor, etc) and are
able to "tear" the tabs off and position them where you want. When you close a tab that has
been moved outside of the standard workspace, the tab is docked back in the workspace.
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Spreadsheet
The data shown in the Spreadsheet view is a direct representation of the devices that are
configured and shown in the selected system workspace. If a logical system is selected, only the
devices for that selected logical system and its sub-systems (if any) display. Select the desired
system from the Browser, or select a logical system tab from the main application view first,
then switch to the Spreadsheet tab. The Spreadsheet tab, similar to the Workspace tab, also
provides the ability to select a device and have the device properties display in the Property
Editor for edit.

The Spreadsheet view is divided into device categories and displays both visual and text
indication of the device linked, synchronization, and online status.

Configuring your Columns

You can configure the columns that appear for each device category by clicking the button
that corresponds to the category title. From the Select Columns dialog, you can move columns
around between the Available Columns and Displayed Columns section. Use the double and
single right-facing arrows (A) to move all or just the selected columns, respectively, from
Available Columns to Displayed Columns. In similar fashion, use the left-facing arrows (B) to
move from Displayed Columns to Available Columns. Use the up and down arrows (C) to order
the Displayed Columns. You can also drag and drop Displayed Columns vertically to change the
order.
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Note: The column selections you make will persist even after you restart the Concert
application.

Device Status Columns
The majority of the columns that appear for your devices are device property columns, however,
some of them display status information. These include the Linked, Sync Status and Online
columns.

Linked

The Linked column in a device category displays the link status of the device. This status
updates in real time when connected to a networked system and refers to whether the device in
the configuration is associated with (linked to) an online device.

Displayed values include:

• No - device is not linked
• Yes - device is linked
• Pending - device link is pending

Sync Status

The Sync Status column in a device category displays by text status and color code the
synchronized status of the device. This status provides indication when the values of the device
on the network and the values in the Concert configuration differ.

Displayed values and color code includes:

• In Sync (green background) - the information Concert has is the same information in the
networked device

• Out of Sync (red background) - the information Concert has is different to the information
in the networked device

• Pending Sync (yellow) - Concert is in the process of collecting enough information from
the device to determine the sync state

• Unknown (black) - Concert cannot communicate with the device (e.g. the device is
offline), so the sync state cannot be determined
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Note: To synchronize the network devices and the Concert configuration, use the
provided [Synchronize Configuration] button in the toolbar, or select Synchronize
Configuration from the Network menu.

Online

The Online column in a device category displays the online/offline status of the device.

Possible values and color codes include:

• Online (green background) - the device is connected (linked) and Concert can
communicate with it.

• Offline (red background) - the device is not connected and Concert cannot communicate
with it.

Working with the Spreadsheet

Context Menus

Context menu options are provided in the Spreadsheet view including device specific actions
that are determined by the specific device package. Right-click on a device in the Spreadsheet
to display the context menu options for the device.

For example, a Gateway context menu provides options to configure the gateway ports, link
to or unlink from the network device, send or receive the device configuration, identify an
RDM device, and delete the device from the configuration.

Sorting Data in Spreadsheet

From the Spreadsheet tab, you can sort the displayed device category table data in ascending or
descending order. For example, click the column header "IP Address" to sort all devices in that
device category by the IP address.
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The column header displays a character next to the title which defines which sort was applied to
the table:

• ˄ ascending - meaning the data will be arranged smallest to largest.
• ˅ descending - meaning the data will be arranged largest to smallest.

Note: Re-sorting the data in the tables does not affect the configuration.

Change Column Width

Column widths default to fit the header name provided. To change the column width, place the
mouse cursor on the line between two columns in the column header. The pointer changes to a
double-headed arrow.

Click with the left mouse button and drag the double-headed arrow to widen or narrow the
column.
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Expand / Collapse Device Category

Click on a device category header to expand or collapse that section in the Spreadsheet view.

Rearranging Columns

Columns within each device category in the Spreadsheet view can be rearranged. Simply click
and drag a column by its header row to its new location in the spreadsheet. Column
arrangement will reside with the configuration.

Editing Data

Click anywhere in the row of data to select a device property for edit. Object selection tracks
within the Browser, and the Property Editor populates with the selected device property data.
Double click inside a cell to edit its text properties or select from the drop down or selection box
when provided.

Only certain properties can be edited. Any property that cannot be edit displays with a gray tint
to the text.

Cell Navigation

Navigation within the spreadsheet is simple and can be done using your mouse cursor or by
using the left (← ), right (→ ), up (↑ ), down (↓ ), Enter, Tab and F2 keys on your keyboard. Use
F2 to edit the selected cell and Enter to confirm the selected value.

Device Property Change Indication

When a property has been edited and the property values differ between your instance of
Concert and the network, the cell appears with a light blue tint. This provides a simple visual
indicator that the device property has changed but has not yet been resolved across the
network. If you hover your mouse cursor over the changed property, the values that are local
and on the network are displayed. The local value is what you have edited in Concert and the
network value is what is currently configured on the device. Synchronizing your device causes
the local value to push to the network.
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Standard Editing Conventions

Standard Windows® table editing conventions may be used including cell selection, copy, cut,
delete, paste and range select.

Note: Multiple cell selection and range select may be used only in a single device
category. You cannot select multiple devices from different device categories for edit.

Search

The Spreadsheet view provides a Search field to quickly locate devices in the list by name,
filtering out all other devices in the list. The search feature performs a case insensitive search of
the device Name. Clearing the Search entry field restores the full content of the Spreadsheet
view.

Property Editor
The Property Editor shows the properties of the selected device(s) and makes those properties
available for edit as needed. The properties available for each device are unique to the device
type and the version of software the device is currently running.
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Multiple Devices Selected
Each device has its own set of properties, therefore the properties in the editor are dependent
on the selection. When more than one device of the same type is selected, the editor pares
down the properties and allows edits only to the common properties of the selection. Editing a
property with multiple devices selected, applies the edit to all selected devices.

Editing a property
Properties are grouped together into categories that can be expanded or collapsed. Some
categories can have additional nested property groups as well. Properties that are not editable
will be shown in gray text. To edit a property, double-click to begin editing the property value.

Note: Preferred properties concerning the IP addressing of a device, including IP
address, Subnet Mask, and Gateway, are not editable from the Property Editor while in
Live Edit.
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When a property has been edited and the property values differ between your instance of
Concert and the network, the cell appears with a light blue tint. This provides a simple visual
indicator that the device property has changed but has not yet been resolved across the
network. If you hover your mouse cursor over the changed property, the values that are local
and on the network are displayed. The local value is what you have edited in Concert and the
network value is what is currently configured on the device. Synchronizing your device causes
the local value to push to the network.

Runtime Properties
Many devices have runtime properties (read only) which provide basic information such as the
temperature of a Sensor rack or which preset is active on a Desire fixture. Not all devices
support runtime properties.

Browser
The Browser shows a hierarchy tree view of the entire project, displaying the contents in the
World View first and any Logical Systems next. The Browser features a Search entry field that
filters the content in the device list by name.

• The first item in the Browser is the World View . The world view is a container for all

hardware devices that have been discovered and have available information in the
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• configuration. Each device in the world view is displayed with an icon and its configured
device name.

• Logical systems are the second top level node in the Browser. Logical systems are

created by users as a way to divide and manage the devices from the World View that are
discovered and have available information in the configuration.
- Logical systems can be nested; meaning a user can create multiple sub-systems inside a
logical system, where the devices that are in the logical system are sub-divided again at
a user's will into one or more sub-systems.

Using the Browser
Use the Browser to navigate to and select a device for modification in the Property Editor. You
can also range select multiple devices for modification at once using (Shift) + click, and you can
copy and paste objects between logical systems, or sub-systems.

Search

A Search field is provided in the Browser to quickly locate devices by name. The search will filter
the devices by World View first, then displaying devices by Logical System. With a search
defined, all other content in the Browser is filtered out. To restore the full content, remove the
text from the Search field.

Send Device Configuration

Select a device, or select multiple devices, in the Browser and right-click. Select " Send Device
Configuration" from the context menu to send the current configuration to the selected device
(s).

Retrieve Device Configuration

Select a device, or select multiple devices, in the Browser and right-click. Select " Retrieve
Device Configuration" from the context menu to retrieve the selected device(s) configuration.

Link To or Unlink From Network Device

The "Link State" of a device indicates how it is associated with an online device. Reference
Linked for more information. The linked state of a device in a configuration can be changed
manually by selecting a device, or select multiple devices, in the Browser and right-click.



Application Overview 20

Select " Link To Network Device" from the context menu to associate the selected device with
a networked device.

Select "Unlink From Network Device" from the context menu to disassociate the selected
device from the networked device.

Tip: When Concert is connected to a networked system and the device is still
available in the system, the unlinked device will display in the "Unlinked" tab of
Discovered Devices.

Delete Item

Select "Delete" from the context menu to delete the selected device(s) from the configuration.

Tip: When Concert is connected to a networked system, and the deleted device is
discovered, it will display in the "Unlinked: Discovered Devices tab.

Find Device

If you have a large system with a lot of mapped devices, locating them can require a lot of
scrolling and searching. Using the Find Device function takes you directly to the device of your
choosing. Right-click on a device in the Browser and select " Find Device" and the focus of the
workspace or spreadsheet will automatically shift to the selected device.
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Error Status
A summary of the current errors logged to the connected Net3 Conductor system for the
currently selected logical system are displayed in the Error Status. The data displayed is read
only.

When the World View is the currently selected system, all logged errors display. Error states
display for the selected logical system regardless of the Live Edit state. Error State is determined
on a per device basis and describes the current list of errors that are affecting the device.

Indicator State
The Error Status indicator, located in the first column of the Error Status table, can show three
indicator states:

• A red blinking indicator is shown for errors which have been posted within the last two
minutes.

• A red solid indicator is shown for errors which are still present and have been for more
than two minutes.

• A green indicator is shown for errors which have been cleared within the last two minutes.
After two minutes have elapsed, items with the green indicator will be cleared from the
list.

Error Display at Devices

When an error is present for an online device, a caution icon displays on the device icon
that has the error when viewed in the workspace. You can also view the errors for a particular
device in the workspace by hovering your mouse over the device. A pop-up displays with
important information regarding the device and its errors.
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Discovered Devices
The Discovered Devices shows a tab for each device categorywhere one or more devices have
been discovered.

Display Format
Discovered Devices can be displayed in an icon view (default) or list view by selecting the
related format buttons.

• Icon view - view the list of discovered devices displayed as icons.

• List view - view the list of discovered devices as a sortable table.

Add Discovered Devices into the Configuration
To configure Discovered Devices, drag and drop a device into the workspace. To add multiple
devices from the device category into the configuration, select all devices and drag them into
the workspace or right-click in the Discovered Devices and select "Add Selected Devices"  or
"Add All Devices" from the context menu.

• "Add Selected Devices" adds all devices that are currently selected into the
configuration.

• "Add All Devices"  adds all discovered devices in the device category into the
configuration.

Reference:Linked for more information.

Search
Search field is provided in the Discovered Devices section to quickly locate devices by name.
With a search defined, all other content in the Discovered Devices section is filtered out. To
restore the full discovered device content, remove the text from the Search field.
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Device Library
The Device Library shows devices that are known to Net3 Concert; meaning the device package
for that device has been installed and enabled using the Component Manager. Use the Device
Library to add devices to the configuration which are not present on the network. For example,
when you are configuring a system offline.

Device Categories
The devices in the library are organized into device categories, with each category being
represented with a tab.

Currently defined device categories are:

• All - all devices from all categories
• Arch. Controllers - Paradigm Architectural Control Processor (P-ACP) and Paradigm
Central Control Server (P-CCS)

• Consoles - Eos and Cobalt family consoles
• Gateways - ETC Gateways and Net3 Conductor
• Networking - Networks
• Power Controllers - Sensor+ rack, Sensor 3 rack, FDX 3000 rack, ERP
• RDM - RDM devices attached to ETC Gateways or the Gadget interface

Adding Devices
Drag and drop any device from the Device Library into the Workspace to add an instance of that
device to the configuration. Devices in the Device Library can either be online or offline when
added to the configuration as the actual binding to a hardware device takes place in a separate
"Link to Network Device" action.

Note: By default, Concert adds the device with properties based on the latest
software version. If you need to pre-configure a device running an older software
version, reference Adding Devices with Older Software Versions

Adding Devices with Older Software Versions

To add a device into the workspace with a previous version of software, drag a device from the
Device Library and press the CTRL key before releasing. A dialog displays listing all available
software versions for that device type. Select the desired version and click [OK].
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Device Operations
The Device Operations allows you to configure specific values for Sensor 3 racks, ETC Source4
LED, Desire and ColorSource fixtures. To access the Device Operations dock, select one of these
devices from the Workspace. From the Viewmenu, select Docks > Device Operations.

Sensor 3 Rack
For Sensor 3 racks, you can use the Device Operations dock to set levels, check dimmers and
manage presets and rig check looks.

Note: Each tab in the Sensor 3 Device Operations dock has a selection list for Space.
If your system has more than one Net3 Space, ensure that you have the appropriate
space selected before making changes.

Set Levels

The Set Levels tab has two sub-tabs that you can use to set levels at your Sensor 3 rack. The Set
Levels sub-tab is selected by default and allows you to set dimmer levels for the circuits in your
spaces.

To set levels from the Set Levels sub-tab:

• Set your range of circuits using the number thru number fields
• Use the slider or percentage field to set the desired level for your circuits
• Click [Set] to set the circuits in the specified range to the currently selected level
• Click [Release] to release the set levels on the selected range of circuits
• Click [Release All] to release set levels for all circuits in the selected space

From the Set Levels sub-tab, select the range of circuits for which you want to set a level. Use
the slider or the percentage field to adjust the level for the selected range of circuits.
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Dimmer Check

The Dimmer Check sub-tab allows you to run through the circuits in a space to test their output
at a given percentage.

Consider the following when using the Dimmer Check sub-tab:

• Enter the circuit number that you want to check in the Check Dimmer field
• Use the slider or percentage field to set the desired level at which to check your circuit
• Use the [Previous] and [Next] buttons to step through the circuits sequentially - clicking
these buttons sets the next or previous circuit to the level selected

• Click [Release] to release the set level for the currently selected circuit
Presets

The Presets tab allows you to manage your presets for your Sensor 3 rack.

Consider the following when using the Presets tab:

• Enter the preset you want to work with (1-64) in the Preset field
• You can activate, deactivate and record the currently selected preset using the respective
buttons
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Load Recording

The Load Recording tab allows you to manage your rig check.

Note: The Rig Check features are only available if the rack property AF Enabled is
set to Yes.

The following buttons are available:

• [Record Rig Check] - Record a rig check preset
• [Play Back Rig Check] - Run the rig check preset
• [C lear Rig Check] - Clear the recorded rig check

Supported ETC Fixtures
For ETC Source4 LED, Desire, and ColorSource fixtures, you can use the Device Operations dock
to manage presets and sequences.

Presets

From the Presets tab, you can play and stop presets on your fixture as well as live and blind edit
the presets on your device.
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Consider the following when working with presets:

• You can select the preset number (1-12) and then define Fade Time and Delay Time in
the format mm:ss

• Enter values for Hue (course and fine), Saturation, Intensity and Strobe
• Or select a color from the color wheel to auto-populate the Hue and Saturation fields
and use the slider on the right of the color wheel to adjust the Intensity field

• If a preset is active while you are changing color, the preset is edited in real-time and the
changes are immediately visible. If the preset is not active, the changes are stored until
the next time the preset is played back.

• The [Capture DMX Values] button will snapshot the current DMX values into the
selected preset. The Hue, Saturation and Intensity values are updated to reflect the
information being sent to the fixture over DMX.

Note: Desire and Source4 LED fixtures must be set to HSI mode and ColorSource
fixutres must be set to RGB or 5 Channel mode if you want to capture presets from
Device Operations. The [Capture DMX Values] button is disabled when your fixtures
are note set to an appropriate mode.

Sequences

From the Sequences tab, you can play and stop sequences on your device. Select a sequence to
edit from the Sequence field (1-12).
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Use the and buttons to add and remove steps to the sequence and then associate
your presets with your steps. You can also select rate (%) of the sequence and the end state
(Loop or Bounce). Finally, enter a value for Link Time for each step.

Once you have added the steps and associated presets, click Play to view the sequence.

Notes
The Notes feature allows users to create and maintain text notes about a configured device in
Concert. Notes are saved as part of the Concert Configuration File and are stored per device
only.

Note: The Notes dock is not displayed by default. To display the Notes dock in the
application view, navigate to the Viewmenu, select Docks, then select Notes.

Create a Note
When a note is attached to a configured device in a logical system, that note will be visible for
the selected device as it is shown in the world view and any other logical system that device is
configured.

1. Select a device in the workspace. The Notes dock enables for text edit.
2. Create the text note for the selected device in the Notes dock.
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When the device is deselected, the notes about that device are also deselected. When the
device is selected again, the notes about that device are shown again in the Notes dock (if
displayed). When no device is selected, the Notes dock is disabled.

Fonts and Formatting

The Notes dock provides tools to change the text font, font size, and apply character formatting
to notes text.

Bold

To make a letter, word, entire sentence or paragraph bold, select the text then click the [B]
button in the Notes toolbar.

Apply Character Formatting

To apply character formatting to a letter, word, entire sentence or paragraph, select the text
then click the fly-out menu button in the Notes toolbar.

Font Type and Size

To change the font for a letter, word, entire sentence or paragraph, select the text then choose
a new font type from the available system fonts in the fonts drop down list. To change the font
size, select the text and choose the new size (in points) from the font size drop down list or type
the value into the list box.

Status Bar
Net3 Concert provides a status bar located in the bottom right corner of the application display.

The status bar provides the following information regarding the Concert application and the
connected networked system.

• Gadget [unique ID] Connected - when a Gadget USB to DMX/RDM Interface is connected
to the computer running Concert, the Gadget serial number displays in the status bar.
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Note: If more than one Gadget is connected, the lowest serial number at the time of
application start up displays.

• Configuration: Online devices - shows the number of online devices in the current
configuration.

• In-Sync - shows the number of connected devices that are in sync (meaning the network
device has the same configuration as the device in Concert)

• Out-of-Sync - shows the number of connected devices that are not in sync (meaning the
network device has a different configuration than the device in Concert)

• Online Devices Indicator - the color of the LED indicates the status of all linked devices in
the configuration.

- Red - all linked devices are offline.
- Green - all linked devices are online.
- Yellow - some (not all) linked devices are online.
- Gray - no linked devices are in the current configuration

• Conductor Connection Indicator - a Net3 Conductor image is displayed in the furthest right
side of the status bar when a Conductor is found and connected to the network. When no
Conductor is found online and connected, no image will display in the status bar.

Component Manager
The Component Manager displays a list of all device packages that are currently installed and
available for use in a configuration. Device packages can also be added, deleted, or updated
from Component Manager. Updates are downloaded from the ETC FTP site or Conductor.
Downloads from Conductor are only available if it is detected on the network.

Note: Adding, deleting, or updating device packages requires a restart of the
Concert application.

Launch the Component Manager by selecting the Component Manager icon in the toolbar or
by selecting " Component Manager..." from the Options menu. Devices are shown in device
categories. Net3 Concert allows management of more than one version of a device package,
which is useful when use of multiple firmware versions are necessary.

The Component Manager interface contains expandable sections that correspond to each
device category. Expanding the categories displays the device packages that are installed,
along with the firmware versions they support, the package version and the package release
date. When downloading an update from the ETC FTP site, a progress bar also appears.
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Incompatible Device Package

If a warning icon appears on the right-hand side of the Component Manager, this means
there are device packages installed that have a firmware version incompatible with Concert.
Clicking the warning icon displays the "Unsupported Device Packages" dialog, from which the
unsupported device packages can be either deleted or replaced.

Add Device Package

Click the select device package button to select a device package to add. The "Select
Device Package" dialog displays.
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The listed items in the table includes all detected device packages found in the default directory
of the host computer.

Download Device Package

Click the download device package button to download any updated device packages from
the ETC FTP site or Conductor, if applicable. If connection to the FTP site is not available, an
error message appears. If connection to the FTP site is successful, a progress bar appears and
indicates the progress of the download.

During the download, each combination of device and version is checked to determine the
following:

• If Concert already has the device package for the device and version specified
• If the version available is newer than the version currently in Concert

If Concert does not have a specific device package, it is added through the download. If the
version available is newer, the device package is updated. If any errors occur, the download
stops and an error message appears. If no errors occur, all new and updated device packages
appear in Component Manager.

Delete Device Package

Click the delete device package button to remove the currently selected device package
from Concert. Deleting a device package means that Concert no longer supports the device
package. A warning message appears confirming that the device package should be removed
and no longer supported.

Icons and States
Each device in the workspace is represented by an icon; a graphical representation of the device
itself. In addition to the device icon, up to three state icons (indicators) can display to provide
visual status indication in the Workspace of each device.



33 Net3 Concert User Guide

Device Icon
Device icons shown in the workspace are acquired from the device package for the specific
device. These icons are meant to be the direct representation of the device to aid in system
design and configuration.

Concert Instance Icon

Many times there will be more than one instance of Concert running and connected to the
control system. Quickly determine which instance of Concert is yours by locating the Concert
icon with the bubble icon (similar to an "You are here" icon in mapping software). In addition to
the bubble icon, your instance of Concert is labeled with your computer IP Address.

Hover to view Tooltips

Hovering the mouse pointer over a device icon displays additional information about that device
in a tool tip.

Note: CID and DCID information displays in the tool tip only when the preference
for display is selected.

Single-Click to Select Device

Click on a device in the workspace to select the device. The device selected displays in a
dashed box around the device icon, the properties for the selected device display in the
Property Editor, and the Browser expands to display the selected device.
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Double-Click to Display Mini Editor

Many devices feature a configuration mini editor, allowing configuration of the device
parameters. Double-click a device icon in the workspace to display the device configuration
mini editor when it is available. Reference "Configuring Devices" for details to configure
devices using the available mini editors and the Property Editor.

Note: Whether or not a particular device includes a configuration mini editor is
determined in the device package installed. Certain devices, such as the Paradigm
products, do not allow configuration within Net3 Concert. Any ETC device that is not
directly configurable within Concert has other effective purpose-built methods of device
configuration available. Contact ETC Technical Services for assistance.

Note: Double-clicking on the Net3 Conductor device icon when it is connected to the
network displays the Conductor web user interface in a new window.

Sync State Icon
Concert determines whether the networked device and the Concert configuration match
through some very basic criteria including matching the device IP address and other device
properties. Different visual indications of the synchronization state appear for each device in the
workspace.

The sync state for a device is represented as follows:

In Sync - A green dot in the lower right-hand corner indicates the information in
Concert is the same as the information in the networked device.

Out of Sync - A red dot in the lower right-hand corner indicates the information
Concert has is different to the information in the networked device.

Pending Sync - A yellow in-progress icon indicates that Concert is in the process of
collecting enough information from the device to determine sync state.

Can't Sync - (this state is also considered "unknown") - Concert cannot
communicate with the device to determine the sync state. Possible reason could be because the
device is offline. When a device can't sync, the device icon is faded and has an "X" through it.
Hovering the mouse pointer over the device provides more information.

Link State Icon
The link state of a device also provides a visual indication in the workspace of the current linked
state of the device in the Concert configuration and its linked association with an online
network device. Net3 Concert determines and automatically associates between a device in the
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configuration and a discovered device on the network using discrete information such as
matching CIDs, matching IP address, by Group/Rack number for dimmer racks, or by RDM ID for
RDM devices.

When a device is unlinked, the device icon is faded and has an "X" through it. Hovering the
mouse pointer over the device provides more information.

New Project Properties
Project properties are important job related information such as the job name, job number,
revision number, address and site contact information.

The Concert project Filename, when saved, is derived from the project name, project number,
and revision specified in these properties.

Note: The job name is required before the wizard will allow progression through to
the next display. The job number and revision are optional, but when supplied are a
suffix to the Filename. A project saves as a *.ccz file type.
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Tip: Changing the revision number (from the Property Editor) at any time after the
project is created will display a "Save as" dialog, allowing multiple revisions of the
same configuration.

The remaining data properties are optional but are also important as they are saved with the
configuration. "Date" and "Software" fields are read only. "Filename:" displays the directory
path where the new configuration will save. To change the directory, click the [Browse...]
button to the right of the path.

Click [OK] to display the application view.

Tip: TIP: When the project name has been defined and the Project Properties dialog
closed, the configuration file name is located at the top left of the application window.
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Menu

The following menus are provided for quick access to Concert file operations, configuration and
device features.

• File
• Edit
• Network
• View
• Options
• Tools
• Help

File
The File menu provides basic tools allowing you to create, open, and save configurations as well
as configuration level features for adding and removing logical systems, importing and exporting
device configurations, and performing a Network Map.

New Project

Displays the NewProject Properties dialog. If a configuration file is already open, you will be
prompted to either save or discard the current configuration data. You may also use keyboard
shortcut CTRL + N.

Open Project...

Displays the Launch Project dialog. You may also use keyboard shortcut CTRL + O.

Save Project

Saves the current configuration.You may also use keyboard shortcut CTRL + S
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Note: If the current configuration has never been saved, the "Save Configuration"
dialog displays for specification of the file name and directory.

Save Project As...

Displays the "Save Configuration" dialog for specification of the file name and directory.

Add Logical System

Displays the "Add Logical System" dialog for specification of the Logical System Name.

Tip: When adding a logical system to a configuration, the view that is in focus (World
View or other Logical System) will be the parent logical system. The parent logical
system is identified in the "Add Logical System" dialog.

Remove Logical System

Displays a fly-out menu for selection of the logical system you want to remove from the
configuration. When the logical system is selected, a dialog displays for confirmation of the
selection. Resolve the dialog by selecting either [Yes] or [No].

Network Map

Performs a Network Map. Reference Network Map for more information.

Live Edit

Toggles the configuration in and out of Live Edit mode when the host computer is connected to
a networked system.

Edit
The Edit menu provides editing tools including Cut, Copy, Paste, Edit Space Names, Delete, and
a variety of selection tools.

Cut

Use to remove a selected object (device, shape, or text) from its current location. Alternatively,
you may use keyboard shortcut CTRL + X.
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Copy

Use to copy a selected object (device, shape, or text) for later pasting in a different location.
Alternatively, you may use keyboard shortcut CTRL + C .

Paste

Use to paste an object (device, shape, or text) that was previously cut or copied to the clipboard.
Alternatively, you may use keyboard shortcut CTRL + V.

Edit Space Names

Use to open the "Edit Space Names" dialog.

Delete

Use to permanently delete a selected object(s) (device, shape, or text). Alternatively, you may
press the (Delete) key on the alphanumeric keyboard.

Select All Devices

Selects all devices in the current logical view.

Select All Graphical Items

Selects all graphic items (shapes, lines, etc.) in the current logical view.

Select All

Selects all devices and graphic items in the current logical view. Alternatively, you may use
keyboard shortcut (CTRL) + A.

Network
The Network menu provides tools to manage the configuration over the network.

Note: When working offline, the options in this menu are not selectable.

Send System Configuration

Sends the entire Concert configuration to all linked and online devices in the system. This action
overwrites all device configurations with the new configuration data. A "Send Network
Data" dialog displays for confirmation of the configuration update to the view's devices. Click
[OK] to send the configuration or [Cancel] to abort the update.

Retrieve System Configuration

Retrieve configuration data from all linked and online devices, updating their associated
configurations in Concert. This action overwrites all device configuration in Concert with the
new retrieved configuration data. A "Retrieve Network Data" dialog displays for confirmation of
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the configuration update to the views devices. Click [OK] to send the configuration or [Cancel]
to abort the network configuration overwrite.

Note: Which devices in the Concert configuration receive the new configuration from
the networked devices is determined by which view is in focus. If the Retrieve System
Configuration action is submitted with the World View in focus, all devices in the
Concert configuration that are linked and online with a networked device will receive
the new device configuration. If a logical system is in focus, or a sub-system of a logical
system is in focus, only the devices for that system will receive the new network device
configuration.

Send Device Configuration

Select a device or select multiple devices (press CTRL then click to select devices), then select
" Send Device Configuration" from the View menu to send the Concert configuration to only
the selected linked and online devices. This action overwrites all selected device configurations
with the new Concert configuration data. A "Send Device Configuration" dialog displays for
confirmation of the configuration update, overriding the device with values from the
configuration. Click [Yes] to send the configuration or [No] to abort the update.

Retrieve Device Configuration

Retrieve device configuration data from selected linked and online devices, updating their
associated configurations in Concert. This action overwrites all device configuration in Concert
with the new retrieved device configuration data. A "Retrieve Device Configuration" dialog
displays for confirmation of the configuration update . Click [Yes] to send the configuration or
[No] to abort the network device configuration overwrite.

Synchronize Configuration

Working with an online networked system, but not in Live Edit mode, Concert determines if the
values of the device(s) on the network and the values in the Concert configuration differ. When
these values are different, the device will display a Sync Status icon in red, meaning it is out of
sync, and the " Synchronize Configuration" option in the Network menu is enabled. Select
" Synchronize Configuration" to process a configuration sync. The "Synchronize Devices"
dialog displays for resolution. Reference Synchronize Devices Dialog for information to resolve
this dialog.

View
The View menu provides options to view the different features of the Concert application.

Docks

The Docks sub-menu provides access to show or hide each individual application feature, such
as the Property Editor, Discovered Devices, Device Library, Browser, Error Status, Notes and
Device Operations. An application feature that is shown in the application, displays with a
check mark.
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Note: You must have an RDM device selected in the Workspace for the Device
Operations dock to be available.

Layout

The Layout sub-menu provides access to many of the same tools that are provided in the "View
toolbar" as well as additional features to save and restore layouts.

Grid and Zoom tools

Reference Viewtoolbar for instruction to use the Show/Hide Grid, Snap to Grid, and Zoom
features.

Restore Default Layout

Select "Restore Default Layout" to restore the application display to its factory defaults,
removing all user adjustments to the location of the docks.

Import Layout

Select "Import Layout" to import a layout file was previously exported. A "Import Layout" dialog
displays for selection of the *.ini file. Browse to the file location and select [Open]. The
imported layout is immediately applied to the current application view.
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Export Layout

Select "Export Layout" to export the current application view to an *.ini file. A "Export Layout"
dialog displays for selection of the location the *.ini file should be stored. This *.ini file includes
the description of the current layout of windows and tabs.

Log Reporting

The Log Reporting sub-menu provides access to the tools to create, run, and delete log reports.
Log messages are the historic data about events in the system that are stored on a connected
Net3 Conductor.

Note: The Log Reporting feature is available only if the Net3 Conductor is detected
on the network.

• To create or edit a log report, reference Report Wizard.
• To run an existing log report, reference Run Report.
• To delete an existing log report, reference Delete Report.

Options
The Options menu provides access to the UpdaterAtor, Component Manager, Find
Unreachable Devices, and access to application Preferences.

UpdaterAtor

Reference UpdaterAtor for more information.

Component Manager...

Reference Component Manager for more information.

Find Unreachable Devices

Reference Find Unreachable Devices for more information.

Preferences

Reference Preferences for more information.
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Tools
The Tools menu allows you to perform the following tasks:

• Import CEM+, CEM3 and ERP configurations
• Save or restore CEM3 archives
• Open the Paradigm LightDesigner and ControlDesigner applications

CEM+
The CEM+ option allows you to import the configuration files for a CEM+ device.

From the Import Device window, browse to and select the four .xml files that are necessary to
complete the CEM+ configuration.

DMX Gateway
The DMX Gateway options allow you to enable fast RDM device discovery and turn RDM on and
off for the entire system.

• Using the Turn Off RDM and Turn On RDM options allows you to easily disable or enable
RDM for all gateway ports in your system.

• Selecting the Fast RDM Discovery option causes all gateways in the system to perform
rapid discovery of connected RDM devices.
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CAUTION: The Fast RDM Discovery operation can impact DMX performance so
you should not use this feature during a showor time where DMX performance is
critical.

Note: If you use the Fast RDM Discovery feature from the Tools menu, you must
remember to disable RDM once you are done, as this feature enables RDM for all
gateways in the system.

CEM3
The CEM 3 options allow you to import a CEM3 configuration file and new device or archive a
copy of the .etc configuration files for CEM3 power control systems that are online. The menu
also provides a way to restore the settings from saved .etc configuration files to the CEM3
systems.

Import CEM3 configuration

This menu selection allows you to browse to a CEM3 configuration file (*.etc) on your network.
When selected, the configuration imports and a new deviec is added to the currently selected
view.

Save to CEM3 Archive

This menu selection displays the "Save CEM3 to Archive" dialog. To save the .etc configuration
files for a CEM3 system, select the check box for the corresponding CEM3 system. Click [Select
All] or [Select None] to select or deselect all CEM3 systems in the list.
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Click [Next] to display a second dialog from which a save location can be selected. Once a save
location is selected, click [Next] again. The default save location is in the Concert
Configurations folder with a filename in the format CEM3Archive_YYY_MM_DD_HHMM.zip.

As the CEM3 configuration files are archived, a new dialog displays the progress bar indicator
for each CEM3 system that is being saved.

Once the archive is saved, click [Finish].

Restore from CEM3 Archive

This menu selection displays the "Restore from CEM3 Archive " dialog. To restore the

configuration from saved files, use the browse button to select the archived file from
which to restore and click [Next].
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Click [Next] to display a second dialog from which the CEM3 systems to restore can be
selected. Click [Select Online] or [Select None] to select all CEM3 systems online or none,
respectively. To select the CEM3 systems individually, use the corresponding check boxes.

Click [Next] to restore the CEM3 systems. A third dialog displays the progress for each CEM3
system being restored. Click [Finish] once all systems are restored.

Paradigm
The Paradigm options allow you to open either the Paradigm LightDesigner or ControlDesigner
applications.
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ERP
The ERP option allows you to import the configuration file for an ERP device.

From the Import Device Configuration window, browse to and select the ERP configuration (.cfg)
file to complete the ERP configuration.

Help
The Help menu provides the following options:

Overview: Access to launch this online help system (Overview) as well as access to the "About
Net3 Concert" dialog.

Device Help: Access to device-specific help topics. If you have any device packages installed
that include their own help, the device has a selection option from this sub-menu.

About Net3 Concert:

Select "About Net3 Concert" to show the dialog listing the Net3 Concert version number,
version numbers for the additional libraries including the application CID and copyright
information.

If you are running a Beta version of Concert, a beta release indicator marks this screen.
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Toolbars

Toolbars are provided for quick access to the many features and functions of Net3 Concert.
Tools are divided into functional toolbar groups:

• Main
• Configuration
• View
• Options
• Drawing

Main toolbar
The Main toolbar consists of the NewProject, Open Project, Save Project, Network Map and
Live Edit buttons.

Tip: Many of these tools are also available in the File menu.

New Project -

Click the [New Project] button to create a new project. If a current configuration is open, a
dialog will request confirmation to [Save] or [Discard] the current configuration or [Cancel] the
action.

• Select [Save] to save the current configuration. A "Save Configuration" dialog displays.
Complete the save action by supplying a file name and clicking the [Save] button.

• Select [Discard] to discard the current configuration. All configuration information will be
lost.

With completion of either the [Save] or [Discard] selection, Concert displays the NewProject,
Project Properties dialog for specification of the new project properties.

Open Project -

Click the [Open Project] button to open an existing configuration. If a current configuration is
open, a dialog will request confirmation to [Save] or [Discard] the current configuration or
[Cancel] the action.

• Select [Save] to save the current configuration. A "Save Configuration" dialog displays.
Complete the save action by supplying a file name and clicking the [Save] button.

• Select [Discard] to discard the current configuration. All configuration information will be
lost.
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With completion of either the [Save] or [Discard] selection, Concert displays the "Launch
Project, Load Existing Project" dialog, displaying all previously saved configurations for
selection. Select the desired configuration from the list and click [Open]. If the configuration is
stored in a different directory than the default, click [Browse] to locate the directory.

Save Project -

Click the [Save Project] button to save the current configuration.

• If the current configuration has been previously saved, or has had a file name specified on
project creation, the save action will automatically save the configuration information to
the determined path. No further action is required.

• If the current configuration has never been previously saved and the project information
has not been specified, the "Save Configuration" dialog displays. Complete the save
action by supplying a file name and clicking the [Save] button.

Network Map -

Click the [Network Map] button to perform the Network Map feature. Concert will close any
existing open configuration and begin the network discovery process, displaying the progress for
verification.

When the discovery is complete, the network map displays in the World Viewof the
Workspace .

Note: After the Network Map is drawn, any new devices that are discovered will
display in the Discovered Devices panel.

Live Edit -

Note: The Live Edit button is disabled when working offline from a networked
system.

Click the [Live Edit] button to place Concert into Live Edit mode or click it again to toggle it out
of Live Edit mode. Changes made to the configuration parameters, and therefore to a device,
while in Live Edit mode are immediately applied to the device. When Concert is not in Live Edit
mode, any changes to the configuration are retained in memory and may be synchronized to the
device at a later time, or saved as part of the configuration file.

Note: Some devices may not support Live Edit mode due to its own device
limitations. The behavior of these devices when Concert is in Live Edit mode are
specified in their device package.

Configuration toolbar
The Configuration toolbar consists of the Send System Configuration, Retrieve System
Configuration, Send Device Configuration, Retrieve Device Configuration and
Synchronize buttons.
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Note: The Configuration toolbar is disabled when working offline from a networked
system.

Tip: Configuration tools are also available in the Network menu.

Send System Configuration -

Click the [Send System Configuration] button to send the entire Concert configuration to all
linked and online devices in the system. This action overwrites all device configurations with the
new configuration data. A "Send Network Data" dialog displays for confirmation of the
configuration update to the view's devices. Click [OK] to send the configuration or [Cancel] to
abort the update.

Note: Which devices receive the new configuration is determined by which view is in
focus. If the Send System Configuration action is submitted with the World View in
focus, all devices that are linked and online will receive the new Concert configuration.
If a logical system is in focus, or a sub-system of a logical system is in focus, only the
devices for that system will receive the new Concert configuration.

Retrieve System Configuration -

Click the [Retrieve System Configuration] button to retrieve configuration data from all
linked and online devices, updating their associated configurations in Concert. This action
overwrites all device configurations in Concert with the new retrieved configuration data. A
"Retrieve Network Data" dialog displays for confirmation of the configuration update to the
views devices. Click [OK] to send the configuration or [Cancel] to abort the network
configuration overwrite.

Note: Which devices in the Concert configuration receive the new configuration from
the networked devices is determined by which view is in focus. If the Retrieve System
Configuration action is submitted with the World View in focus, all devices in the
Concert configuration that are linked and online with a networked device will receive
the new device configuration. If a logical system is in focus, or a sub-system of a logical
system is in focus, only the devices for that system will receive the new network device
configuration.

Send Device Configuration -

Tip: This feature is the same as selecting "Send Device Configuration" from the
Network menu or by selecting "Send Device Configuration" from the context menu
after right-clicking on a device in the Browser, World View, or Logical System view.

The [Send Device Configuration] button is available when one or more devices are selected in
the World View, Logical System view, or the Browser. Select a device or select multiple devices
(press CTRL then click to select devices), then click the [Send Device Configuration] button to
send the Concert configuration to only the selected linked and online devices. This action
overwrites all selected device configurations with the new Concert configuration data. A "Send
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Device Configuration" dialog displays for confirmation of the configuration update, overriding
the device with values from the configuration. Click [Yes] to send the configuration or [No] to
abort the update.

Retrieve Device Configuration -

Click the [Retrieve Device Configuration] button to retrieve the device configuration data
from selected linked and online devices, updating their associated configurations in Concert.
This action overwrites all device configurations in Concert with the new retrieved device
configuration data. A "Retrieve Device Configuration" dialog displays for confirmation of the
configuration update . Click [Yes] to send the configuration or [No] to abort the network device
configuration overwrite.

Tip: This feature is the same as selecting "Retrieve Device Configuration" from the
Network menu or by selecting "Retrieve Device Configuration" from the context menu
after right-clicking on a device in the Browser, World View, or Logical System view.

Synchronize -

Working with an online networked system, but not in Live Edit mode, Concert determines if the
values of the device(s) on the network and the values in the Concert configuration differ. When
these values are different, the device will display a Sync Status icon in red, meaning it is out of
sync, and the [Synchronize Configuration] button is enabled. Click the [Synchronize
Configuration] button to process a configuration sync. The "Synchronize Devices" dialog
displays for resolution. Reference Synchronize Devices Dialog for information to resolve this
dialog.

View toolbar
The View toolbar provides options to change the view of the workspace and how graphic
features interact with the workspace and consists of the Show/Hide Grid, Snap to Grid and
Zoom buttons.

Show/Hide Grid -

A grid is useful for laying out devices symmetrically. Toggle the [Show/Hide Grid] button to
either show or hide the grid in the workspace.

Tip: Show/Hide Grid tools are also available in Layout options of the Viewmenu.

Snap to Grid -

The Snap to Grid option helps you to position devices accurately in the workspace. Click the
[Snap to Grid] button to toggle the snap to grid feature on or off.

Tip: Snap to Grid tools are also available in Layout options of the Viewmenu.
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Zoom
Four zoom tools are available to change the workspace view area including Zoom Out, Zoom
In, Zoom to Extents, and Zoom to Level.

Tip: Zoom tools are also available in Layout options of the Viewmenu.

Zoom In/Out

The [Zoom Out] and [Zoom In] buttons zoom the currently visible workspace view, increasing
or decreasing the view by 20% of the current value with each new zoom request.

Tip: Alternatively, use your keyboard and mouse to zoom the currently visible
workspace. First, click inside the workspace to select the window. Hover the mouse
pointer in the workspace, specifically in the area to affect the center of the zoom. Then
press and hold the [CTRL] button on your keyboard while scrolling the mouse wheel.

Zoom to Extents

The [Zoom to Extents] button zooms the graphical view of the currently selected workspace to
show all devices.

Zoom to Level

To set a specific magnification level, choose a level in the Zoom to Level box .

Options toolbar
The Options toolbar consists of the UpdaterAtor, Component Manager and Find
Unreachable Devices buttons.

UpdaterAtor -

Note: UpdaterAtor is disabled when working offline from a networked system.

UpdaterAtor facilitates the update of device firmware over the connected network.

Click the UpdaterAtor button to launch UpdaterAtor. For additional information, refer to the
UpdaterAtor Software Quick Guide from the ETC Website.

Tip: UpdaterAtor is also available from the Optionsmenu.

https://www.etcconnect.com/
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Component Manager -

The Component Manager is the gate keeper for device package installation, removal, and
update. When a device package is installed, that device is made available in the Device
Library.

Tip: It is common and acceptable to have multiple versions of the same device
package with different firmware version numbers installed for use in a configuration.

Click the [Component Manager] button to launch the dialog. Any device package shown in
the Component Manager is currently installed either on the host computer running Concert or
are on the connected Net3 Conductor. For additional information, see the Component
Manager topic.

Find Unreachable Devices -

Click the Find Unreachable Devices button to open the "Unreachable Devices Wizard".

Drawing toolbar
The Drawing toolbar provides options to create and manipulate different graphical objects
within the Workspace. Additionally, any graphical object created using the Drawing toolbar can
be linked to a Logical System. To create this link, select a graphic and modify the Hyperlink
property in the Property Editor. Enter the exact text used to define the Logical System Name in
the Hyperlink property to create the hyperlink.

To enable graphic hyperlinks, select the Lock Graphics option from the Drawing toolbar. When
locked, clicking a graphic hyperlink centers the Workspace on the corresponding Logical
System. Using graphic hyperlinks can be helpful for navigating larger systems. For example, a
system map consisting of graphical objects that are linked to Logical Systems can allow for quick
transitions between the areas needing attention.

Select -

The [Select] button is also the default drawing tool that is enabled (also called select mode) in
Concert and allows common interaction with graphic items such as devices and interconnecting
lines in the Workspace. To toggle out of select mode, choose any other drawing tool from the
Drawing toolbar. Select mode is toggle enabled again when the alternate drawing tool is
deselected.

In select mode, the cursor shown when the mouse pointer hovers the workspace is a standard
pointer (arrow). When you hover over a graphic object, the cursor displays cross hairs, which
allows you to click and drag the object freely. When selecting a graphic object, nodes appear on
the corners and centers of the object sides, which allow for resizing and movement of the
object.
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Line -

Select the [Line] button to enable drawing of straight lines in the Workspace. The mouse cursor
changes to a cross hair and the line properties appear in the Property Editor.

Line Width

Line width is represented in pixels. As desired, increase or decrease the line width from the
default or specify a numeric entry in the box provided.

Line Color

Click to select a color from the basic colors provided, use the color spectrum provided, or specify
HSV or RGB values. When mixing custom colors, click the [Add to Custom Colors] button to
add the custom color to the library for future use. When the desired color is selected, click the
[OK] button to close the dialog.

Hyperlink

Enter a valid URL in the hyperlink to be opened when the shape is clicked.

Shapes
You can use the different shape tools to draw shapes in the workspace.

Tip: The behavior of the shape tools in the workspace differ when "Snap to Grid" is
turned on or off.

Ellipse/Circle

Select the [Ellipse/Circle] button to enable drawing of ellipses in the workspace. The mouse
cursor changes to a cross hair and the common shape properties appear in the Property Editor.
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When drawing an ellipse, a left mouse-click on the workspace determines where the corner of
the shape begins. Hold the mouse button and drag the mouse across the workspace (drag left,
right, up or down) to draw the shape. To restrain the shape to a circle, press and hold the Shift
button on your keyboard.

Rectangle/Square

Select the [Rectangle/Square] button to enable drawing of rectangles in the workspace. The
mouse cursor changes to a cross hair and the common shape properties appear in the Property
Editor.

When drawing a rectangle, a left mouse-click on the workspace determines where the corner of
the shape begins. Hold the mouse button and drag the mouse across the workspace (drag left,
right, up or down) to draw the shape. To restrain the shape to a square, press and hold the Shift
button on your keyboard.

Polygon

Select the [Polygon] button to enable drawing of a polygon shape in the workspace. The
mouse cursor changes to a cross hair and the common shape properties appear in the Property
Editor.

With the polygon tool enabled, left mouse click in the workspace to start the polygon shape.
Line segments are joined together continuously at a point with the next mouse click. Further
points are added with each mouse click.

Freehand

Select the [Freehand] button to enable free form drawing in the workspace. The mouse cursor
changes to a cross hair and the common shape properties appear in the Property Editor.

With the freehand tool enabled, press and hold the left mouse button and move the cross hair
throughout the workspace, drawing the desired shape. When the left mouse button is released,
click and hold again to start a new segment to a different shape.

Common Shape Properties

The following common properties are available from the Property Editor when you have selected
a shape tool or a shape that is already created.

Line Width

Line width is represented in pixels. Double-click the Value column of the Line Width property to
edit the line width.

Line Color

Double-click the Value column of the Line Color property to open the color picker.

Fill Pattern

Double -click the Value column of the Fill Pattern property to open the fill pattern selection
menu.
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Tip: You can preset a fill pattern to be a pplied to a shape before actually drawing the
shape in the workspace if you have the shape tool selected first, specify the fill, then
draw in the workspace. If you are applying a fill to a shape after it has been drawn in
the workspace, select the image in the workspace first, then apply the fill using the fill
tools.

Fill Color

Double-click the Value column of the Fill Color property to open the color picker.

Hyperlink

Hyperlinks allow you to use shapes as links to navigate from one logical system to another. For
example, if you name a logical system “Dimmer Room”, and enter “Dimmer Room” as the
hyperlink for the shape, when you click on the shape (and graphics are locked), the application
will switch to the Dimmer Room logical system.

Text -

Select the [Text] button to enable text insertion into the workspace. The mouse cursor changes
to a cross hair and additional text property tools are added to the Drawing toolbar. These
additional tools allow specification of font, font size and color. Click to select the fly-out button
on the right side of the drawing toolbar to access these additional tools.

With the text tool enabled, click inside the workspace. A text container is added with a cursor
for alphanumeric text entry. Enter the desired text into the provided container. Press the
[Select] button to disable the text tool or press the ESC button on your keyboard to return to
select mode.

Font

Apply a system font to the text in the workspace by selecting the font from the fonts drop down
box.

Font Size

Specify a font size (in points) for the text displayed in the workspace in the available font size
drop down box.
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Font Color

Click to select a color from the basic colors provided, use the color spectrum provided, or specify
HSV or RGB values. When mixing custom colors, click the [Add to Custom Colors] button to
add the custom color to the library for future use. When the desired color is selected, click the
[OK] button to close the dialog.

Image -

Select the [Image] button to enable the addition of an image to the workspace.

With the image tool selected, click inside the workspace location where the image should be
positioned. The [Add Workspace Image] dialog displays for specification of the image file.

Note: Concert accepts the import of images that are of the following file types: .emf,
.wmf, .jpg, .jpeg, .jfif, .jpe, .png, .bmp, .dib, .rle, .gif, .emz, .wmz, .pcz, .tif, .tiff,
.cgm, .eps, .pct, .wpg, .xpm

Browse to and select the image file, then click [Open].The top left corner of the image is
inserted in the location of the initial mouse click. Press the [Select] button to disable the image
tool or press the Esc button on your keyboard to return to select mode. In select mode, you can
reposition the image in the workspace as needed.

Connection -

The [Connection] button allows connections to be made or edited between devices in the
workspace. Connections are the connecting lines that display in the workspace, providing visual
indication of which products are connected together and what type of connection they share.

The type of connections that can be made may include DMX A, DMX B, Ethernet, etc. These
connection type properties are defined in the device package and added to the preferences.
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Note: Refer to the "General" tab in preferences to specify a different color for the
connection type.

If the connection tool is the active drawing tool, when the mouse is hovered over a device the
list of connection types available for that device is shown.

Select the connection type from the available list to begin creating the connection. Then hover
the mouse over the device to be connected. The list of connection types available for that device
is shown.

Select the connection type from the available list to complete the connection.

Note: The list of possible connections is restricted to the connection type being
made. For example, a connection from a DMX type cannot be connected to an
"Ethernet" type connection point.

Alignment -

The alignment tools allow for the alignment of items in the Workspace. The alignment action
selected from the menu is carried out on the items that are selected.
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Align Left

Aligns the left edges of the selected items with the left-hand most edge of the selection.

Align Right

Aligns the right edges of the selected items with the right-hand most edge of the selection.

Align Center

Aligns the centers of all the selected items with the vertical center line of the selection.

Align Top

Aligns the top edges of the selected items with the topmost edge of the selection.

Align Middle

Aligns the centers of all the selected items with the horizontal center line of the selection.

Align Bottom

Aligns the bottoms of all the selected items with the bottommost edge of the selection.

Distribute Horizontally

Distributes the items horizontally by equalizing the white space between the items.

Distribute Vertically

Distributes the items vertically by equalizing the white space between the items.

Lock -

The locking tools allows for the locking of graphical items, such as switches or background
images, as well as devices.

Lock Graphics

Locks any graphics that are selected. Once locked, graphics cannot be moved or selected.
Locking graphics enables graphic hyperlinks.

Lock Devices

Locks any devices that are selected. Once locked, devices cannot be moved but can still be
selected.
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Preferences

Select "Preferences" from the Options menu to open the Preference dialog. The Preferences
dialog allows user access to change and set Concert application preferences. This dialog is
divided into three tabs of settings; General, Network Access, and Units and Display.

General

The General tab offers general Net3 Concert application settings :

• Automatically launch Synchronize Devices dialog. - this check box is selected by default
and controls whether the "Synchronize Devices" dialog displays automatically when
devices are detected as going out of sync.

• Logging Verbosity: - select the level of application logging messages you want written to
the Concert log file.
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Note: This setting should only be changed if advised to do so by ETC Technical
Services.

• Enable User Defined Workspace Grid Size: - select a custom workspace grid size (in
pixels) from the selection box.

• Connection Colors: - customize the data connection point color (e.g. DMX A, DMX B,
Ethernet, etc.) that displays as the connector lines between devices in the workspace.
These connections are made automatically when the "Network Map" feature is used or
added manually when using the Connection tool from the drawing toolbar.

• Dimmer Doubling Properties - select the check box to "Enable Dimmer Doubling property
configuration" then define the default dimmer doubling value to be used by products that
support dimmer doubling, such as the CEM3 and Gateways. By default, this value is set to
20000. This value is stored as a system preference.

• Workspace Caption Font - select the font type, size and color that will be used for all
device icons in the workspace. By default, this values is set to Arial type, size 12 pt, black
color. This value is stored as a system preference that will be maintained through a
Concert application restart.

• Display CIDs and DCIDs in device tooltips - select the check box to enable the display of
CIDs and DCIDs when hovering over a device in the workspace.

• Get Device Packages from the ETC v3.0.0 Beta FTP site - select the check box to get beta
device packages when they are available.

Network Access

The Network Access preference provides the access to change the selected network interface
cards (NIC or adapter) for use with the configuration. The table displayed is similar to the
Network Interface Selection table shown at the initial start up of Net3 Concert.
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Tip: ETC lighting networks typically use a 10.101.x.x IP Address structure. A list of
ETC product specific IP Addresses is available from ETC Technical Services.

A selected NIC displays with a selected check box, meaning a check mark displays in the check
box. To deselect a NIC, click the check box, removing the check mark and leaving the box
empty. Select [OK] to process the change.

Units and Display

The settings in the Units and Display tab determine how Net3 Concert displays certain quantities
that have units, such as temperature and Streaming ACN values.
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Temperature
By default, all temperature properties default to "Fahrenheit". Alternatively, select Celsius from
the drop down box, then click [OK] to set the preference and close the preferences dialog. All
represented values will change to reflect the changed selection preference.

Streaming ACN
By default, all Streaming ACN address properties default to "Universe/Address" (e.g. 2/356)
where the 2 represents the universe (or port) and the 356 represents the address. Alternatively,
select "Absolute" from the drop down box which changes the address property to an absolute
value (e.g. 868). Click [OK] to set the preference and close the preferences dialog. All
presented values will change to reflect the selection preference.
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Configuring Devices

Concert features the ability to configure a wide variety of ETC products. For complete
information on the exact parameter functions of each device, consult the related product
manual for the device. ETC user documentation is available for download from the ETC website
HTTP://www.etcconnect.com.

Within Concert, the most common parameters for each device may be accessed from within the
Property Editor or Spreadsheet view. For more complex devices with complex settings, a
device specific editor, also called a mini-editor, is available for use within Concert.

Open a device editor by double-clicking on a device in the Workspace view, or by right-clicking
and selecting an editor from the context menu in either the Workspace or Spreadsheet views .

Reference the following sections for configuration details:

• Sensor 3 with CEM3 Configuration
• Sensor+ with CEM+ Configuration
• Gateway Configuration
• RDM Device Configuration

Sensor 3 with CEM3 Configuration
Concert supports configuration of CEM3 control modules when installed in Sensor 3 dimmer
racks (software version 1.2.2 and above) and FDX 3000 dimmer racks (software version 1.4.0
and above).

To configure a CEM3 device that is present in the configuration, double-click on the device icon
in the Workspace or right-click on the device icon and select "Dimmer Properties" from the
context menu. Alternatively, when operating in the Spreadsheet view, right-click on the device
row and select "Dimmer Properties" from the context menu.

http://www.etcconnect.com/
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The Sensor 3 Rack (CEM3 Rack) dimmer property editor displays.

Reference Dimmer Properties Editor for configuration information.

Add a Sensor 3 or FDX 3000 Dimmer Rack from the Device Library

When adding a Sensor 3 or FDX 3000 dimmer rack with CEM3 control module to the
configuration from the device library, drag and drop the device from the Power Controllers tab
into the Workspace or Spreadsheet view. A "Setup Rack" dialog displays for specification of
the rack details.

Note: When adding a device to the configuration from the device library using drag
and drop, Concert by default adds the device's with its latest software version device
package into the configuration. To specify a different software version for the device,
drag the device from the device library, then press and hold the CTRL button before
releasing the device into the Workspace or Spreadsheet view. A "Choose Device
Version" dialog displays for specification of the installed device package to be used in
the configuration.

Only installed device packages display in the "Choose Device Version" dialog. To
install a different device package for the device, reference the Component Manager.
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Provide rack information to complete the dialog and click [OK] to continue.

• Quantity - specify the number of racks you would like to add.
• Rack Voltage - choose the voltage and class of rack (portable, installation, etc), that you
would like to add from the available options in the drop down box.

• Rack Type - choose the type of rack to add into the configuration.
• Advanced Features - click the check box to select whether you would like this rack to
use the Sensor Advanced Features system. For more information on Advanced Features,
consult the CEM3 User Manual.

• First Rack Number - choose the initial rack number that will be used. The rack number
for each subsequent rack added to the configuration will increment by one.

• First Circuit Number - choose the first circuit number assignment to the first dimmer in
the rack. Circuit numbers increment by one for each circuit in the rack.

• IP Addressing - choose the IP addressing scheme. Select either Automatic IP Addressing
or Manual IP Addressing schemes for the racks you are adding.
- Manual IP Addressing setting will place a static address in the configuration for the
Sensor 3 rack being specified. With Manual IP Addressing selected, the default starting
IP Address is 10.101.101.101 for the first rack. The IP Address for each subsequent rack
specified in this dialog will automatically increment by 1. ETC lighting networks typically
use a 10.101.x.x IP Address structure. A list of ETC product specific IP Addresses is
available from ETC Technical Services. With Manual IP Addressing, you will also supply
the Subnet Mask and Gateway for the device. Typically, ETC lighting control systems
use Subnet Mask 255.255.0.0 and Gateway 10.101.1.1.

- Automatic IP Addressing (also known as Dynamic Addressing) will work in conjunction
with a DHCP server attached to the network. This would typically be the connected
Net3 Conductor. With Automatic IP Addressing, the starting IP Address, Subnet Mask,
and Gateway fields are no longer selectable.

Dimmer Properties Editor

The Dimmer Properties Editor allows you to edit the configuration of dimmers or ranges of
dimmers in your Sensor 3 rack and FDX rack. You can make changes in a variety of ways,
including editing dimmers in the Table View, the Property Editor, using the Renumber
Dimmers Dialog dialog, Import an ODS File or Import CEM+ configuration file.
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Table View

The most common properties for the Sensor 3 dimmers are shown in the table view of the
selected rack as well as in the Property Editor. A summary of the purpose of each property can
be viewed by hovering the mouse over the name of the property in the Property Editor . For
complete information about the function of each property, refer to the Sensor 3 CEM3 User
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Manual. To edit any individual values in the table, simply click on the cell you wish to edit.

The following columns are shown in the table for edit:

Lug

Lug is the physical position of the circuit in the rack, starting at the top and working downwards.

Circuit

Circuit is the logical reference number for the circuit (sometimes known as Dimmer Number).
This is an editable, user assignable reference for the specific dimmer.

Name

Name allows you to give each circuit a free-text name. The name will be shown in ETC Eos
family consoles when Advanced dimmer feedback is enabled. Refer to the Sensor 3 CEM3 User
Manual for information regarding Advanced Features.

Module

Module defines the type of module that is or will be physically installed in the rack. ETC
produces a wide range of dimmer modules for different applications, including dimming, relay
and thru-power modules.

Firing Mode

Firing Mode controls the manner in which the dimmer controls it's output.

Control Mode

The Control Mode of a dimmer controls the relationship between the control input (DMX, sACN)
to the dimmer and it's output. Use this Control Mode property to set a dimmer to be switched,
dimmable, smoothed, latchlock, always on or off.

Curve

Curve controls the "shape" of a dimmer's output. Sensor 3 dimming systems have a variety of
curves available, as well as the ability to work with user defined curves. Custom Curve Editor
for more information.

DMXA, DMXB and sACN

The DMXA, DMXB and sACN columns contain the patch information of how the three possible
control inputs to the rack relate to the dimmers. In US (SR) systems, columns are also available
for Dimmer Doubled (DD) circuits.
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User Data

User Data allows you to associate up to 8 free-text fields (similar to meta-data or meta-tags)
with a dimmer for additional identification.

Property Editor

The Property Editor lists all properties of the selected dimmer(s). This editor allows you to view
and alter every property of the dimmers in one simple interface. The Property Editor also allows
you to edit multiple dimmers at once (unlike the table view which only allows editing of a single
value at a time). Additional properties available in the Property Editor for the Sensor 3 rack
with CEM3 control include:

For full details on the functions and available values for each feature, reference the CEM3 User
Manual.

Regulation Properties
• Threshold(%) - In switched mode the threshold value defines the control percentage at
which the output turns on. In dimmed mode, the threshold defines the level at which
preheat is applied.

• Voltage Regulation - When enabled, the dimmer will maintain the desired output voltage
based on the mapping of control level to scaled curve for the voltage output. When
disabled, the dimmer will be set to a constant firing time based on the control level.

• Min Scale (V) - This value is the lowest output level of a circuit once it is turned on at its
control threshold. When preheat is enabled, the output is at min scale below threshold.
When preheat is disabled, the output goes to zero.

• Max Scale (V) - This value is the highest output level of a circuit at 100% control.
• Scale Load (%) - The scale load setting allows hyper-accurate regulation of the voltage of
the dimmer output. The scale load allows the CEM3 dimming engine to compensate for
power losses occurring in the choke of the dimmer. The scale load is calculated as the
load on the channel divided by the channel’s capacity (in Amperes) and is expressed as a
percentage. For example, a 5A load on a 20A channel would have a scale load of 25%
(5A / 20A x 100% = 25%).

Preheat
• Preheat - Enable or disable preheat.
• Preheat Time - Preheat Time value allows the preheat level to be sneaked back in after a
blackout to allow rapid snap blackouts. This property specifies the length of time for the
ramp back to preheat level. Default = 2 seconds.

DC Prevent
• DC Prevent - If enabled, ensures that both positive and negative half cycles of the dimmer
output are always equal. This setting is typically used for loads sensitive to DC for example
transformers and electronic loads.

Inrush Prevent
• Inrush Prevent - Provides a soft start feature when lamps are turned on from “0” by
ramping up the level over three main cycles.

Control Properties

Spaces are logical divisions within a system that isolate station control (preset and sequence
control) to the defined group of controllable outputs in that division. CEM3 supports separation
of its controllable circuits into spaces and allows configuration of up to 16 presets per space.
Each space can only have one active preset at a time.

• Space - the combination of circuit number and space number must be unique. Values
range from 1 to 255. Supply the space number in the value field.

• Allow in Preset - Click to enable this circuit for recording into a preset.
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Panic Properties

CEM3 offers a Panic capability that complies with UL 924 Panic functionality. When a properly
connected and enabled CEM3 has a panic “look” stored, when it receives a signal over the
panic circuit it will automatically play the recorded look. Panic can be enabled when a
maintained contact closure is properly wired to the back plane (for more information, see the
data termination guide or installation guide that was supplied with the Sensor 3 rack).

• Allow in Panic - Determines if this circuit should be included in the panic look.
• Allow DD in Panic - Determines whether the dimmer-doubled B side of the circuit can be
recorded as part of the panic look.

Wild Cards in Text Fields

When editing text fields in the Property Editor (such as the Name and User Data fields), you can
use special character sequences to create helpful names. Each of the wild cards shown below
will be automatically replaced by the appropriate value for all of the dimmers being edited.

Wild card Replaced With
%C The current circuit's Circuit Number
%L The current circuit's Lug Number
%R The current Rack Number
%S The current circuit's Space Number
%O The current circuit's sACN address
%A The current circuit's DMX A address
%B The current circuit's DMX B address
%U The current circuit's sACN universe value
%E The current circuit's sACN absolute value
%M1 - %M8 The current circuit's user data (value 1 thru 8)
%I The index in the order in which these circuits were selected

Circuit and Patch Editing

When you select a range of lugs and edit the circuit number or DMX or sACN address values,
the value you enter will be used as a start address, and incremented as it is applied to each lug.

Dimmer Properties Editor Toolbar

Tools are provided in the editor to provide access for dimmer renumbering, importing and
exporting the rack configuration to an ODS file, import a CEM+ configuration, manage User
Data Tags, and select another rack.

Renumber Dimmers Dialog

The Renumber dialog allows renumbering of the whole rack, or of a selection of dimmers within
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the rack. To access the Renumber dialog, click on the renumber dialog button at the top of the

editor ( ).

The Renumber dialog allows selection of what to renumber. This includes just selected dimmers,
the whole rack with straight numbering, or the whole rack with balanced numbering.

• If the Renumber Circuits is checked, the circuits in the rack will be renumbered. If it is not,
numbering will be unchanged, although circuits can still be re-patched and renamed at
the users discretion.

• If Rename Circuits is checked, the selected circuits will be renamed. You can use the
same wild card conventions as shown above.

• For each data port (DMXA, DMXB and Streaming ACN), you can select whether to re-
patch them, either to a selected value, the circuit value plus an optional offset, or to un-
patch them (set them to zero).

Export ODS File

The [Export ODS file] button allows you to export the data from your rack to an Open
Document Spreadsheet (ODS) file format, which can be edited with popular spreadsheet
software such as Microsoft Excel. This can be useful for compiling system data such as load
schedules, and for editing and re-importing data using the ODS import function.

Selecting the [Export ODS file] button displays a prompt for a directory to save the ODS file. A
dialog displays when the data has successfully exported. An ODS file contains the following
data:

• Rack Number
• Lug Number
• Circuit value
• Dimmer Name
• Module Type
• Firing Mode
• Control Mode
• Curve
• DMXA, DMXB and sACN Patch
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• Space
• Any non-empty user data fields

Import an ODS File

The [Import an ODS file] button allows you to import data from an Open Document
Spreadsheet (ODS) file created with spreadsheet software, or a file previously exported from
Concert, or with ETC's Paradigm LightDesigner software.

When you select to import an ODS file you will be first asked to select the file from a directory.
Once selected, Concert ask how you would like to perform the import.

• If you select to import based on Rack and Lug, Concert will look for a Rack and Lug
column in the imported data, and match those to the Rack and Lug number of the rack
you are working in. This mode allows you to set up a single spreadsheet containing data
for all racks and import it into each rack in turn.

• If you select to import based on Circuit, Concert will match dimmers in your rack to values
in the spreadsheet based on the Circuit column. This allows you to import data using
circuit as a key, without having to specify the position of the dimmers in the rack.

Once the data is imported, the changes are applied immediately and are shown in the table
viewof the editor.

Import CEM+

The [Import CEM+] button , selectable only for Sensor 3 dimmer racks, allows you to import
data from a Sensor+ system's (.RAK file), to simplify upgrades from CEM+ to CEM3. As a .RAK
file contains data for multiple racks, when you select a file you will be prompted to select which
rack's data you would like to import.

Editing User Data Tags

Tip: User Data, basically is data about data or could be better defined as the user
defined purpose of the data. Each device offers the ability to include up to eight "User
Data" fields that may be used to supply additional information about the device. User
Data properties display in table view and in the Property Editor.

User Data Tags are provided as a way for user's to setup custom labels for User Data
field as they are displayed in the Property Editor. By default, User Data Tags are
labeled "User Data 1, User Data 2, etc., for each of the eight User Data fields that are
available per object instance. User Data Tags could be considered or used as categories
of User Data.

CEM3 features up to 8 user properties which you can use to classify circuits in the rack. The
titles of these user properties are called user data tags, and may be edited by clicking on the

[User Data Tags] button in the editor toolbar. A Edit User Data Tags dialog is shown
allowing editing of the user data tags from their default names, User Data 1 through User Data
8, in the rack.

Switching Racks

When working in a system with multiple Sensor 3 racks, switch between the available racks in

the logical system you are working in by clicking on the [Select Another Rack] button .
You will be shown a list of other racks in the selected system that you can switch to for
configuration edit.
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LoadMonitoring Viewer

The CEM3 Load Monitoring viewer allows you to view and monitor the load currents of circuits
in your dimming system. Load Monitoring is only available in racks with Sensor Advanced
Features, or FDX racks. To view the Load Monitoring Editor, right-click on a Sensor 3 device icon
in the Workspace and select "Load Monitoring" from the context menu. Alternatively, when
operating in the Spreadsheet view, right-click on the device row and select "Load Monitoring"
from the context menu. The Sensor 3 Load Monitoring viewer displays.

From this viewer, you can choose whether to display all circuits or to filter circuits based on their
status and type.

You can also display circuits from any one rack or from all racks in your system .

Note: When "All Sensor 3 Units in Space" is selected, you will be provided another
filter selection box to specify the space.
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• The Circuit column contains the dimmer circuit number.
• The Load Reporting Mode column shows the load reporting mode of the circuit.
• Recorded Load displays whether a load has been recorded for this circuit or not.
• Current Load displays the current monitored value for the circuit (0-100A).
• Sensitivity displays the level of sensitivity configured for this circuit
• The AF Reaction Time column displays how quickly the circuit has been set to report errors
(in minutes:seconds)

• The Status column displays the load status of the channel - whether is OK or whether it
has a high load, no load, or low load.

Tip: As with all tables throughout Concert, you can sort the table column data
ascending or descending my clicking on the column header.

Save as PDF

To save the displayed table data (as it is displayed) to a Portable Document Format (PDF), click
the [Save as PDF] button on the bottom of the editor. The "Save As" dialog displays for
confirmation of where the file should be saved.

Custom Curve Editor

The CEM3 provides the ability to specify and use custom dimmer curves and to provide a
customized relationship between control input and voltage output of the selected dimmer. To
edit custom curves, right-click on a Sensor 3 or FDX 3000 device icon in the Workspace and
select "Custom Curves" from the context menu. Alternatively, when operating in the
Spreadsheet view, right-click on the device row and select "Custom Curves" from the context
menu. The Sensor 3 Custom Curve Editor displays.
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The custom curve editor allows you to select which rack in the logical system you want to
modify curves for and which curve in the rack you want to edit. Each rack type supports five user
definable curves.

1. Select the rack from the available racks in the "Rack:" drop down box (only the racks that
are in the selected logical system will be available for selection).

2. Next select the curve to edit from the available curves in the "Curve to Edit" drop down
box.

3. Provide a new name for the custom curve in the "Curve Name" field. By default, the
name defaults to Curve 1, Curve 2, etc.

Tip: Curves consist of 21 points in an X-Y graph where the X-axis represents the
control input and the Y axis represents the voltage output of the rack.

Edit a Curve

To edit the selected curve, click on the point (green dot) you would like to edit and drag it to the
new position on the graph, within the points boundaries. These boundaries will be apparent as
you are manipulating each point. The dot color changes to red, indicating it is now the selected
point and the [Apply Changes] button highlights to indicate an edit needs to be saved before
closing the editor. Apply Changes
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Tip: You can also use the keyboard up, down, left and right arrows to move the
selected point within its boundaries in the graph desired. With a point selected,
pressing the Page Up and/or Page Down buttons changes the selected point within the
curve.

If desired, you can initialize the curve to one of three preset types (Linear, Mod-Square or
Switched) using the buttons on the right of the editor.

Copy and Paste Custom Curves

To copy and paste a custom curve between racks in the system, use the [Copy] and [Paste]
buttons to the left of the graph in the editor.

• Click [Copy] to copy the selected curve, then switch to another rack or curve in the logical
system and click the [Paste]button.

• In addition, you can use the paste feature to duplicate the curve to other custom curves as
desired.

Apply Changes

Click the [Apply Changes] button to save the new edited data to the custom curve and to the
selected rack. Click the "Apply To All" check box before clicking the [Apply Changes] button
to apply the edited curve to all racks in the selected logical system.

Sensor+ with CEM+ Configuration
Concert supports configuration of Sensor+ racks with CEM+ control modules that utilize
software version 3.1.1 and above. To configure a Sensor+ device, double-click on the device
icon in the Workspace or right-click on the device icon and select "Dimmer Properties" from the
context menu. Alternatively, when operating in the Spreadsheet view, right-click on the device
row and select "Dimmer Properties" from the context menu. The Edit Dimmer Properties dialog
displays for configuration. Dimmer Properties Editor.

Note: CEM+ does not support Live Editing of its properties. To edit a
CEM+ configuration, first exit Live Edit mode, make edits, then send the edited
device configuration to the CEM+.

For full information about the properties of a Sensor+ dimming system, refer to ETC's Sensor
CEM+ User Manual.

Adding a Sensor+ Dimmer Rack from the Device Library

When adding a Sensor+ dimmer rack with CEM+ control module to the configuration from the
device library, drag and drop the Sensor+ device from the Power Controllers tab into the
Workspace or Spreadsheet view. A "Setup Sensor+ Rack" dialog displays for specification of
the rack details.



Configuring Devices 78

Note: When adding a device to the configuration from the device library using drag
and drop, Concert by default adds the device's with its latest software version device
package into the configuration. To specify a different software version for the device,
drag the device from the device library, then press and hold the CTRL button before
releasing the device into the Workspace or Spreadsheet view. A "Choose Device
Version" dialog displays for specification of the installed device package to be used in
the configuration.

Only installed device packages display in the "Choose Device Version" dialog. To
install a different device package for the device, reference the Component Manager.

Provide Sensor+ rack information in the dialog and click [OK] to continue.

• Group Number - specify the group number for the rack. The "Rack Number" property is
determined automatically as racks in a Sensor+ system are always numbered sequentially
and cannot be created out of order.

• Voltage Setup - select the voltage region for the rack, 120 or 230/240V.
• Rack Type - determine the type of rack to add.

Dimmer Properties Editor

The Dimmer Properties Editor allows you to edit the configuration of dimmers or ranges of
dimmers in your Sensor+ rack.
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The most common properties for the Sensor+ dimmers are shown in the table view. For
complete information about the function of each property, refer to the Sensor+ CEM+ User
Manual. To edit any individual values in the table, simply click on the cell you wish to edit and
enter or select the new value.

The following columns are shown in the table for edit:

• Position - the physical position (lug) of the dimmer in the rack, starting at the top and
working downwards.

• Dimmer - An editable, user assignable reference for the specific dimmer in the rack.
• Name - Name allows you to give each dimmer (circuit) a free-text name.
• Module - Module defines the type of module that is or will be physically installed in the
rack. ETC produces a wide range of dimmer modules for different applications, including
dimming, relay and thru-power modules.

• Mode - Mode controls the manner in which the dimmer controls it's output.
• Curve - Curve controls the "shape" of a dimmer's output. Sensor+ dimming systems have
a variety of curves available.

• Threshold - In switched mode the threshold value defines the control percentage at which
the output turns on. In dimmed mode, the threshold defines the level at which preheat is
applied

• Min Scale - This value is the lowest output level (in Volts) of a circuit once it is turned on at
its control threshold. When preheat is enabled, the output is at min scale below threshold.
When preheat is disabled, the output goes to zero.

• Max Scale - This value is the highest output level (in Volts) of a circuit at 100% control.
• Regulation - When enabled, the dimmer will maintain the desired output voltage based on
the mapping of control level to scaled curve for the voltage output. When disabled, the
dimmer will be set to a constant firing time based on the control level.

• sACN Channel - The Streaming ACN patch of the dimmer.
• EDMX Channel - The EDMX patch of the dimmer.
• DMX A Channel - The patch of the dimmer on the DMX input A to the rack.
• DMX B Channel - The patch of the dimmer on the DMX input B to the rack.
• Preheat - Select whether the dimmer has preheat enabled or not.
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• Preheat Time - Preheat Time value allows the preheat level to be sneaked back in after a
blackout to allow rapid snap blackouts. This property specifies the length of time for the
ramp back to preheat level. Default = 2 seconds.

• DC Output Prevent - If enabled, ensures that both positive and negative half cycles of the
dimmer output are always equal. This setting is typically used for loads sensitive to DC for
example transformers and electronic loads.

• Inrush Protect - Provides a soft start feature when lamps are turned on from “0” by
ramping up the level over three main cycles.

• AF Enabled - Select whether Sensor Advanced Features are enabled for this dimmer.
• AF Sensitivity - Determine the sensitivity of this dimmer to load change. Specified in
Amps.

• AF Reaction Time - Determine how quickly the dimmer reports load errors, in seconds.
• Scale Load - Configures the choke correction in the dimmer module.
• EDMX, sACN and DMX DD - Determine the patch for dimmers using ETCs Dimmer
Doubling feature.

• PTIO (Pass Through If On) - Configure a special relationship between dimmer level and
control prioritization.

EditingMultiple Dimmers

To edit the properties of more than one dimmer at once:

• to range select - select a starting dimmer in the table, then press and hold Shift and left
mouse click the last dimmer in the range selection.

• to select non-sequential - press and hold Ctrl then click non-sequential dimmers in the
table.

When the dimmers are selected, right-click on a selected dimmer and select "Edit Dimmers"
from the context menu. The Edit Dimmers dialog displays, allowing adjustment of multiple
dimmer properties at once.

When you alter properties that apply to multiple dimmers, the property highlights with a blue
background color to indicate it will be applied to all the selected dimmers. Click [OK] to apply
your changes to the selected dimmers or click [Cancel] to abort the changes.

Sequencing Dimmers

To sequence (alter the numbering of a range of) dimmers, select the dimmers you want to
modify in the table, then right-click and select the "Sequence Dimmers" option from the context
menu. The Sequence Dimmers dialog displays.
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Determine how you would like to sequence the dimmers using the dialog.

• Selected Dimmers
• Whole Rack - Straight
• Whole Rack - Balanced

Determine the Numbering (renumbering) for the rack.

• Select a starting address
• Select whether you would like to leave gaps in the sequence for airflow modules or to
"jump over" airflow modules.

• Select to rename the dimmers as you sequence.

Note: When renaming dimmers, wild cards are provided to assist with quick
renaming. Reference the dialog for instructions.

Click [OK] to perform the sequence or select [Cancel] to abort the process. Changes are
applied to the dimmer table immediately.

Configuring Port B Output

Sensor+ racks have the ability to configure the last DMX port in the last Sensor+ rack in the
group as a DMX output from networked data sources (EDMX and Streaming ACN). To configure
the Port B output, right-click anywhere in the editor and select "Setup Port B Output" from the
context menu. The Port B Output Wizard displays for configuration.
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Click the "Enable Port B Output" check box to enable Port B output in the last rack in the group.
Once enabled, configure the relationship between the possible control inputs (DMX A, EDMX
and sACN) and the available DMX output. Use the options in the Quick Setup section of the
dialog to apply a patch to the entire universe, or manually edit the values in the Outputs section
of the dialog.

Refresh from Rack

Retrieves the configuration from the CEM+.
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Gateway Configuration
Concert supports configuration of One-Port, Two-Port and Four-Port Gateways. To configure a
Gateway device that is present in the configuration:

• Double-click on the device icon in the Workspace.
• Right-click on the device and select " Port Configuration" from the context menu .

• Alternatively, when operating in the Spreadsheet view, right-click on the device row and
select " Port Configuration" from the context menu.

The DMX Gateway Configuration Editor displays for port configuration.

Add a Gateway from the Device Library

When adding a Gateway to the configuration from the device library, drag and drop the
Gateway device from the Gateways tab into the Workspace or Spreadsheet view. The device
icon displays in the Workspace or in the Spreadsheet view.



Configuring Devices 84

Note: When adding a device to the configuration from the device library using drag
and drop, Concert by default adds the device's with its latest software version device
package into the configuration. To specify a different software version for the device,
drag the device from the device library, then press and hold the CTRL button before
releasing the device into the Workspace or Spreadsheet view. A "Choose Device
Version" dialog displays for specification of the installed device package to be used in
the configuration.

Only installed device packages display in the "Choose Device Version" dialog. To
install a different device package for the device, reference the Component Manager.

Actions

Actions are available from the context menu of a selected Gateway from the Workspace or
Spreadsheet views. Right-click on a Gateway and select from the available actions in the list:

Identify

Selecting "Identify" from the Gateway context menu sends a command to the Gateway to flash
its backlight (Two-Port and Four-Port Gateways only) or flash its LED (One-Port Gateway) for 60
seconds. The "Identify" option will be disabled from selection if the Gateway is offline.

Restore Defaults

Selecting "Restore Defaults" from the Gateway context menu allows restoration of the Gateway
settings to factory defaults. A warning dialog will display for confirmation of the restore action.
The "Restore Defaults" option will be disabled from selection if the Gateway is offline.

Reboot

Selecting "Reboot" from the Gateway context menu reboots the selected Gateway. The
"Reboot" option will be disabled from selection if the Gateway is offline.
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Restart RDM Discovery

Selecting "Restart RDM Discovery" from the Gateway context menu causes the Gateway to
forget the RDM devices that it currently knows about and performs a rapid discovery cycle on all
of its ports to rediscover devices. The "Restart RDM Discovery" option will be disabled from
selection if the Gateway is offline.

Reset Dynamic IP

Selecting "Reset Dynamic IP" from the Gateway context menu erases the memory of the current
dynamic IP address setting for the selected Gateway and requests a new IP from an online DHCP
server after reboot. The "Reset Dynamic IP" option will be disabled from selection if the
Gateway is offline.

Link or Unlink From Network Device

The link state of a device indicates whether the device in the configuration is linked to
(associated with) an online network device. When the Gateway is associated with an online
device, "Unlink From Network Device" displays in the context menu. When the Gateway is not
associated, "Link to Network Device" displays in the context menu.

Reference Link to Network Device for more information.

Send Device Configuration
• Select "Send Device Configuration" to send the Concert configuration to only the selected linked and
online Gateway. This action overwrites the Gateway configuration with the new Concert configuration
data. A "Send Device Configuration" dialog displays for confirmation of the configuration update,
overriding the device with values from the configuration. Click [Yes] to send the configuration or [No]
to abort the update.

Retrieve Device Configuration

Select "Retrieve Device Configuration" to retrieve device configuration data from selected
linked and online Gateway. This action overwrites the Gateway configuration in Concert with
the new retrieved device configuration data from the online device. A "Retrieve Device
Configuration" dialog displays for confirmation of the configuration update . Click [Yes] to send
the configuration or [No] to abort the network device configuration overwrite.

Delete Item

Select "Delete Item" from the context menu to delete the selected Gateway from the
configuration.

Tip: When Concert is connected to a networked system, and the deleted device is
discovered, it will display in the "Unlinked" tab of Discovered Devices.
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Port Configuration
With the DMX Gateway Configuration Editor displayed, Port Configuration of the selected
Gateway is possible. The available ports of the selected Gateway are displayed with
representative images for the connector types that Concert has detected. When the selected
Gateway is a One-Port, only one port is selectable and configurable.

To select a port for configuration, click on the port. A green arrow displays above the selected
port and the current configuration details of the selected port displays in the dialog. With the
port selected, you may choose to specify the port as an output, input, or disable the port.

Serial Port Configuration

If your gateway contains a Serial port, the Serial properties appear in the Gateway Editor:
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Using the editor, you can configure the Serial Group, Baud Rate, Data Bits, Parity, Stop Bits, and
Flow Control for your serial port.

Additionally, you must select the values for Transmit and Receive. Set Transmit to Yes if there is
serial data being sent over the network that should be routed to the device connected to the
Serial port. Set Receive to Yes if there is serial data being sent to the port from the connected
device which should be sent over the network.

For additional information on sending or receiving serial data to or from an EOS console, refer to
your EOS Family Show Control Setup Guide.

Output mode

Click "Output" to configure the selected port as an output. With a port configured as an output,
the following items are presented for configuration :

• Universe and Address - these parameters are presented if the Gateway port selected for
Streaming ACN is Universe/Address. Universe allows entry of values from 1 to 63999,
Address allows entry of values from 1-512. The {+] and [-] buttons increment or decrement
the value up to the maximum or down to the minimum.

• Length - allows entry of the port length. Allowable values are 1-512, default 512.
• [Dimmer Doubled] - switches the port into or out of dimmer doubled mode.
• [RDM] - toggles between RDM Enabled and Disabled for the selected port.

Note: Dimmer doubling and RDM features are not supported on a one port gateway.

Input mode

Gateways offer two input patch modes, Standard and Advanced.
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Standard Patch

With a port configured as an input and standard patch, the following items are presented for
configuration:

• Universe and Address - these parameters are presented if the gateway port selected for
Streaming ACN is Universe/Address. Universe allows entry of values from 1 to 63999,
address allows entry of values from 1-512. The {+] and [-] buttons increment or decrement
the value up to the maximum or down to the minimum.

• Advanced input patch status - the button to the right of the Universe selection displays
status and provides an action when clicked. When an advanced input patch is defined for
the port, the button displays "AIP Disabled". When an advanced input patch is not
defined, "No AIP Defined" displays. Click the button to revert the display to select a
different patch mode or return to the Advanced Input Patch editor for editing.

• Length - allows entry of the port length. Allowable values are 1-512, default 512.
• [Dimmer Doubled] - switches the port into or out of dimmer doubled mode.

Note: Dimmer doubling is not supported on a one port gateway.

• [Edit Advanced Input Patch] - this button is only shown when the port is configured with
the standard patch editor. Click the button to display the Advanced Input Patch editor.
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Advanced Input Patch

With a port configured as an Input and "Advanced Input Patch" selected, the Edit Advanced
Input Patch dialog displays for patch specification:

Click on the port for advanced input patch configuration. The selected port displays with a green
arrow on top.

Patch Table

The patch table includes two columns of data in the table:

• DMX Input Channel - this column of data runs from 1 to 512 and represents the DMX
address input channel. This column of data cannot be edited.

• sACN Output Address - this column contains the output addresses which the DMX input
is patched to. This column is editable using the following formats:
- Universe/Address (e.g. 2/1). Multiple values may be entered using a commas as a
separator (e.g. 2/1, 3/45).

- Absolute address numbers (e.g. 513) may be supplied (e.g. 513, 45673).

Note: When the sACN output address format provided is invalid, the cell displays
with a pink background. Correct the error by supplying the correct universe/address
format. Concert will not apply the changes or close this dialog with an invalid patch.

Click the DMX Input Channel column header to sort the table channel column data ascending or
descending.
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1 to 1 Patch

To create a one to one patch for the selected port, click the [1 to 1 Patch] button to display the
1-1 Patch dialog.

The one to one patch dialog provides the following options:

• Starting Address (or Starting sACN Universe and Address, depending on the unit setting
for streaming ACN.

• Append to Existing Patch allows Yes or No toggling.
- When Yes is the selection and [Apply Changes] is clicked, the patch table displays with
the advanced input patch appended to it.

- When No is the selection and [Apply Changes] is clicked, the patch table data is
replaced with the advanced input patch data.

Range Patch

Range patching allows you to quickly patch a group of channels to the selected port. Click the
[Range Patch] button to display the Range Patch dialog.

The range patch dialog provides the following options:

• Supply the first DMX address to patch to the selected port in the "From DMX Address:"
field. Use the [+] and [-] buttons next to the entry field to increment or decrement the
numbers or simply enter the address numerically in the supplied field.

• Supply the last DMX address in the range to patch in the "To DMX Address:" field. Use
the [+] and [-] buttons next to the entry field to increment or decrement the numbers or
simply enter the address numerically in the supplied field.

• For devices that support sACN, supply the "Starting sACN Universe:" and "Address" in
the fields provided.
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• Append to Existing Patch allows Yes or No toggling.
- When Yes is the selection and [Apply Changes] is clicked, the patch table displays with
the range patch appended.

- When No is the selection and [Apply Changes] is clicked, the patch table data is
replaced with the start and end DMX addresses or sACN address range patch data.

Clear Patch

To clear only one or more selected rows in the patch table, select the rows fist, then click the
[C lear Patch] button. If no specific rows are selected, press the [C lear Patch] button to clear all
patch data for the selected port.

Copy and Paste Patch Data

Concert offers the ability to [Copy] advanced input patch data from the currently selected cell(s)
in the patch table (port specific) and [Paste] that data to another port. Data copied for the
selected cell(s) are formatted "DMX Input Channel" <tab character> "AIP Data", for as many
cells as are selected when the copy operation is made. Data on the clipboard can be pasted into
the new port selection.

For example: 

• In an advanced input patch with address 1 going to 1/12, address 2 going to 3/19 and
address 3 going to 1/13,1/14. If the advanced input patch cells 1-3 are selected, and the
[Copy] button is clicked, the following data would be copied to the clipboard
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• - 1 <Tab> 1/12
- 2 <Tab> 3/19
- 3 <Tab> 1/13,1/1

• Select a different port, then click the [Paste] button. The pasted data replaces the existing
patch data, but only for the selected and associated rows.

Tip: You must click the [Apply Changes] button to close the Gateway editor and
process the changes.

Disabledmode

When a port is disabled, there are no editable settings.

Find Unreachable Devices
Concert discovers and communicates with compatible devices that are on its network. The Find
Unreachable Devices feature allows discovery of devices that are online but unreachable by
Concert due to their IP address being outside of the subnet range of the PC running Concert or
because the devices are in Net2 mode.

1. Select " Find Unreachable Devices" from the Optionsmenu or click the Find
Unreachable Devices button . The "Unreachable Devices Wizard" displays.

2. Click [Next] to begin the search for unreachable devices. Concert will continuously search
for devices with which it cannot communicate.
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3. To switch unreachable devices from Net2 mode into Net3 mode, click the [Switch Net2
Devices to Net3] button. As these devices switched to Net3 mode, they will display in the
Discovered Unreachable Devices list. Skip this step if you are not switching modes for
unreachable devices.

CAUTION: Clicking the [Switch Net2 Devices to Net3] button will switch all
Net2 devices in the network to Net3 mode. Switching these devices into Net3
mode will remove all Net2 output capability for those devices.

4. Once the device(s) you are looking for are shown in the list, press [Next]. All devices that
were found in the search are displayed for selection.
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5. Select the device from the list which you would like to assign new IP addresses, then click
[Next]. The "Select new IP Scheme" page displays.
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Note: When a DHCP server is online, the Unreachable Devices Wizard will
automatically select "Automatic IP Addressing" as the IP Scheme.

6. Select the method of assigning IP addresses that you would like to apply to these selected
devices from the following options:

• Automatic IP Addressing - The devices will attempt to acquire a new IP address from the
online DHCP address server.If the devices cannot find a server, they will revert back to a
link-local IP address.

• Manual IP Addressing - The devices will be assigned static IP addresses based on the
addressing scheme in the Manual IP Addressing options. By default these options are:
- Assign IPs starting at : 10.101.50.61
- Subnet Mask: 255.255.0.0
- Gateway: 10.101.0.1

7. Depending on the selection:
• If "Automatic IP Addressing" is selected, click [Finish]. Concert will apply the settings and
reboot the device(s).

• If "Manual IP Addressing" is selected, update the Manual IP Addressing fields with new
starting address information according to your network addressing scheme and click
[Finish], Concert will apply the settings and reboot the device(s).

Note: Concert detects IP address conflicts between the starting IP Address numbers
in Manual IP Options and devices that are already in use on the network. When a
conflict is detected, the error message will display and the wizard will be prohibited
from progress until the conflict is resolved.
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RDM Device Configuration
Concert supports configuration of devices that are in compliance with the ESTA/PLASA Remote
Device Management (RDM) standard when they are connected to a Gateway or connected
through a Gadget USB-DMX/RDM interface device.

Note: For Concert to communicate with an RDM device through a gateway, the RDM
feature must be enabled at the gateway and the port the devices are connected to must
be configured as an output. Reference the Gateway configuration for information on
enabling RDM.

Since the individual features available through RDM vary with the device, editing and
configuration of a generic RDM device offline of a network is limited to just the basic label.

Add a RDM Device from the Device Library
When adding an RDM device to the configuration from the device library, drag and drop the
RDM Device the RDM tab into the Workspace or Spreadsheet view. Double-click on the device
icon to display the RDM Device Editor.

Note: When adding a device to the configuration from the device library using drag
and drop, Concert by default adds the device's with its latest software version device
package into the configuration. To specify a different software version for the device,
press and hold the CTRL button on your keyboard, then drag the device from the device
library into the Workspace or Spreadsheet view. A "Choose Device Version" dialog
displays for specification of the installed device package to be used in the
configuration. Only installed device packages display in the "Choose Device Version"
dialog. To install a different device package for the device, reference the Component
Manager.

RDM Device Properties
Using the Property Editor you can quickly set the DMX Personality, DMX Start Address and
Name (RDM Label) of a device.

Identifying an RDM Device
RDM devices feature the ability to identify themselves, typically by blinking their light output,
display or other method. To identify an RDM device through Concert, right-click on the device
icon in the workspace and select "Identify" from the context menu. Alternatively, from the RDM
Device Editor, click the [Identify] button to enable the identify feature for the selected device.
Right-click on the device icon again and select "Stop Identifying" or click the [Identify] button
again in the editor to disable the identify feature.

RDM Device Editor
To view detailed information about a linked RDM device, double-click on the device icon in the
workspace or right-click on the

device icon and select "RDM Device Properties" to open the RDM Device Editor.
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Depending on the device, you can see a variety of tabs for setting different RDM parameters.
For example, an ETC Desire fixture has four tabs (Device Information, Sensors, Presets,
Manufacturer Specific Properties) that are displayed in the RDM Device Editor for user
information or configuration selection.

Device Information
• The "DMX Address" edit allows you to edit the DMX address of the device. The Universe
is displayed based on which port of the DMX gateway the device is connected to.

• "Manufacturer" and "Model" displays the reported manufacturer of the fixture.
• "Model" displays the reported model of the fixture.
• "Label" displays the name (also called RDM label) of the device. From this field you can
also edit the RDM label of the selected device.

• "DMX Personality" allows you to alter the DMX personality the device is configured to
use.

• The DMX Personality table shows details of the DMX personality assigned to the device.

Note: Once you have made changes to the configuration of a RDM device, click the
[Apply Changes] button to apply those changes to the device and close the RDM
Device Editor.

Viewing RDM Sensor Information

The RDM Device Editor provides facilities for a connected RDM device to report sensor data (for
example temperature information). To view data from the sensors of a device, click on the
Sensors tab in the RDM Device Editor. Each sensor in the device is represented in its own tab
(shown at the bottom of the window). This information is read-only.
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Presets

From the Presets tab, you can view which preset is active, activate a different preset, deactivate
the active preset, or record a new preset.

Play Preset

Select the preset number from the "Preset" spin box, then press [Play]. The selected preset will
play the recorded output on the selected device.
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Stop Preset

Press the [Stop] button to stop the currently active preset.

Record Preset

Select the preset number from the "Preset" spin box, then press [Record]. The current output
for the selected device will be recorded to the selected preset number.

Current Active Preset

The bottom right corner of the RDM Device Editor displays the currently active preset. When a
sequence is active on the device, the presets in the sequence will cycle through, displaying the
currently active preset. Alternatively, if there is no preset active "No Preset Active" displays.

Note: Once you have made changes to the configuration of a RDM device, click the
[Apply Changes] button to apply those changes to the device and close the RDM
Device Editor.

Manufacturer Specific Properties

The RDM protocol allows manufacturers to develop special features of their equipment, and to
have configuration tools (such as Net3 Concert) dynamically discover those features. When
these special features are discovered, they are displayed in the Manufacturer Specific Properties
tab. The properties displayed in this tab will vary depending on the device type.

Note: Once you have made changes to the configuration of a RDM device, click the
[Apply Changes] button to apply those changes to the device and close the RDM
Device Editor.

Link to Network Device
The linked state of a device determines whether the device in the configuration is linked to
(associated with) an online network device. Whether a device in the workspace is linked or not
can be determined by its Link State icon and is indicated in the workspace view. Alternatively,
when viewing the configuration in the Spreadsheet view, the Linked status is indicated in text.

Reference Discovered Devices for instructions to add unlinked devices into a configuration.

Synchronize Devices Dialog
The Synchronize Devices dialog shows when there is a difference between the configuration of
hardware devices discovered on the network and the configuration data that is present in Net3
Concert.
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Resolve the conflicting device data by selecting which configuration values should be used for
each device; either the values identified in the actual networked device or the values identified
in the Concert configuration. Each device with conflicting data can be resolved individually or
collectively by selecting the check box for either "All Network Device Values" or "All Concert
Config Values".

• Network Device Config - copies the selected device value and updates the Concert
configuration accordingly.

• "Concert Config" - sends the local values to the selected device.

Select the [Synchronize] button to set the preferred action. The dialog closes and the data is
either sent or retrieved depending on the selection. The status for the selected devices updates.



101 Net3 Concert User Guide

Log Reporting

Concert offers the ability to create and view log reports. Log messages recorded include historic
data about events in the system that are stored on the connected Net3 Conductor.

Log Reporting tools are located in a sub-menu of the View menu.

Note: The Log Reporting feature is available only if the Net3 Conductor is detected
on the network.

• Reference Create or Edit Report.
• Reference Run Existing Log Report.
• Reference Delete Report.
• Reference Working with Logs.

Log reports are stored in the Concert configuration file (*.ccz) and are available to be re-run
during subsequent instances of Concert.

Create or Edit Report
Log messages are the historic data about events in the system and are stored on the connected
Net3 Conductor. Use the Log Reporting feature in Concert to create, edit, run or delete a log
report. Log reports are stored as part of the configuration; they can be recalled, run, and edited
as needed.

Note: The Log Reporting feature is available only if the Net3 Conductor is detected
on the network.

Creating a new log report and editing an existing log report are very similar in process, they are
managed through the Log Report Wizard. The Log Report Wizard is provided to manage the
setup and configuration of the log data including the selection of which space to retrieve log
data, specific devices in the selected space, the type of messages to retrieve, determining a
date and time range, as well as limiting the number of returned messages. Since log messages
are categorized according to how severe the error is, an additional selection of which errors
should be retrieved is also provided.

Log Report Wizard

Follow these steps to create or edit a log report in the Log Report Wizard:

1. Get started by selecting " Create/Edit Log Report..."  from the Log Reporting sub-menu
in the Viewmenu.
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2. The Log Report Wizard - New Report dialog displays. When there are no existing reports
for the configuration, "Create a New Report" is the only selection available. When you
are editing an existing report, select the report name from the "Edit existing report" drop
down.
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3. Click [Next] to continue. The Name and Devices page is displayed for specification of log
report details. When editing an existing report, the existing report specifications display
for edit.

4. Enter a name for the report in the "Report Name" field. This name will be used as the log
report name if you decide to save it for future use. The report name is limited to 32
characters in length.

5. Select the types of messages to display from the available selection. Options include
" Error Data" or "All Log Data" .

• Error Data - the report will display errors logged from the selected devices in the
selected logical system.

• All Log Data - the report will display all log data from all devices in the configuration.
The "Available Devices" and "Selected Devices" selection boxes will no longer be
selectable with this option as all device errors will display in the report.

6. If " Error Data"  is selected, specify which Logical System to retrieve the device errors
from.

Note: Report data is scalable and can include all devices in the world view, or any
parent logical system, or a specific sub-system of a parent logical system. When
determining the system selection, keep in mind that selecting a parent logical system
will include error data of its sub-systems. Selecting a sub-system includes only the error
data from that sub-system.

7. The devices that display in the "Available Device" section are dependent on the logical
system selected. Select the device(s) which should be reported on from the devices
shown. By default, all devices are selected. To remove specific devices, deselect the
check boxes corresponding to the devices. To remove all devices, click theSelect None
button.
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8. Click [Next] to continue. The Select Time Range page displays for specification of the
date range and the limit for the amount of results to return.

9. Select the date range from the available options.
• All Available Information - returns all the information available on Net3 Conductor for
the selected device errors in the selected logical system.

• From the last - a combination box displays including "Day, Week, and Thirty Days".
- Day - returns information from the previous 24 hour period until the current time.
- Week - returns information from the previous seven days up until the current time
(168 hours).

- Thirty Days - returns information from the previous 30 days, including the current
day.

• From: allows specific date range selection.
- Specify the range start date. The start date format is based on the location of the
host computer. For example, dd/mm/yyyy for the UK and mm/dd/yyyy for the USA.

- Specify the range end date. The end date can be a specified date, or select the
"Now" radio button to include all messages from the range start date until the
current time.

10. Select the quantity of messages that can be returned from the available options.
• Return up to - a spin box is provided to select the number of messages. Default value
is 500, but can be any amount between 1 and 3,000.

• Return all results - returns all data without a limit on the message count.

CAUTION: Selecting "Return all results" may result in a slowreport generation
as the data amounts may be high.

11. Click [Next] to continue. The Severity and Verbosity page displays for specification of
which level of error messages you want returned in the log report.
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12. Log messages are categorized according to how severe the error is. Select the severity of
messages you want returned in your log reports from the available options. By default,
Emergency, Alert, Critical, and Error are selected as these error types are deemed the
most important. Change the selection if desired. Items with a check mark will be included
in the report.

13. Click [Next] to continue. The Save Report page displays for selection of what you would
like to do with the new generated report.
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14. Select one of the following options to finish the Log Report Wizard.
• Save Report and Run - Click [Finish]. The report saves to the configuration and can
be regenerated later using the Run Existing Log Report from the Viewmenu. The
report generates the log file and displays as a new tab in the workspace .

• Do not save, just run - Click [Finish]. The report generates the log file and displays
as a new tab in the workspace.

• Do not run, just save - Click [Finish]. The report saves to the configuration and can
be generated later using the Run Existing Log Report from the Viewmenu.

Reference Working with Logs. Logs can be exported to a comma separated value (CSV)
format document for use with external spreadsheet applications such as Excel.

Run Existing Log Report
Concert provides the ability to regenerate log reports that have been saved to a configuration.
Select " Run Existing Log Report" from the View menu.

Note: The "Run Existing Log Report..." option is available for selection in the View
menu only if there is at least one existing saved log report in the configuration.

The Run Report dialog displays for selection of which log report to run.
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Select the report from the list, then click [Run Report]. The report generates the log file and
displays as a new tab in the workspace.

Reference Working with Logs. Logs can be exported to a comma separated value (CSV)
format document for use with external spreadsheet applications such as Excel.

Delete Report
To delete an exiting log report from the configuration, select "Delete Log Report" from the
Viewmenu.

Note: The "Delete Log Report..." option is available only if there is at least one
existing saved log report in the configuration.

The Delete Report dialog displays for selection of the log report to be deleted.
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Select the desired report and click [Delete Report]. The selected log report is deleted from the
configuration.

Working with Logs
When generated, log reports display in a tab within the workspace. Multiple log reports can be

open at one time and can be closed independently by selecting the close button next to the
name on the tab.
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Searching within Logs
A Quick Search box is provided on the top right corner of the displayed log tab, allowing a quick
search of the generated data. When text is entered in the Quick Search box, the log report
updates to show only rows which meet the search criteria supplied.

This search tool is a case-insensitive wild card match to the text entered in the Quick Search
box.

Sorting Columns
Sort the data in the report by selecting the column header. A caret displays to indicate the
selected by column sort is either ascending ˄ or descending ˅ .

Export Log Files to CSV
Any generated log file can be exported to a comma separated value (CSV) file for use with an
external common spreadsheet applications, such as Numbers or Excel. With the log report
displayed, right click in the table and select " Export Report as CSV" from the context menu.
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A Save Report as a CSV File dialog displays. Browse to the directory location to save the file,
provide a file name, then click [Save].

Find a Device in Workspace
To locate a device in the configuration from the generated error in the current log report, right-
click on that device in the table and select " Find Device in Workspace" from the context
menu. Concert responds by changing the focus of the workspace to the selected device. If the
report was generated with dependencies on a specific logical system, the focus will change to
that specific logical system tab with the device selected. A selected device displays with a
selection box in the workspace.
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Glossary

ACN
ANSI E1.17 Architecture for Control Networks (ACN) communications protocol is a suite of
seventeen network protocols for theatrical show control, developed by Entertainment Services
and Technology Association (ESTA). ACN was designed as a control architecture for audio,
lighting, video playback servers (media servers) and similar systems. The protocol is designed to
be layered on top of UDP/IP and therefore will run over standard, inexpensive Ethernet and
802.11 (Wi-Fi) network links.

Bind
The association of a graphical or logical object in Concert's configuration to a physical piece of
hardware on the system. This can also be referred to as linking.

See also Linked, Link to Network Device , and Icons and States.

Browser
A hierarchical representation of the configuration as a tree-type view.

See also the Browser topic for details of use within the Concert application.

CID
A CID is a 128-bit number used to uniquely identify a particular device.

Component Manager
Concert manages device packages through the Component Manager. This feature allows the
installation, update, or removal of device hardware compatibility.

Concert Configuration File
The Concert Configuration file is the master configuration file saved by Concert (*.ccz) and
contains all information from Concert and all device specific configuration information.

Tip: When a configuration change has not been saved to the configuration file, an
asterisk displays in the configuration file name located at the top left of the application
window.

Concert Software Suite
The combination of the Concert application software and networking hardware used to
configure and monitor connected ETC systems.

DCID
A DCID is a 128-bit number used to uniquely identify a particular type of device.
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Device Category
Device categories are defined to group together different devices of the same class within the
library.

Currently defined device categories are:

• Gateways - Gateways and Conductor Network Services Gateway
• RDM - RDM devices attached to ETC gateways or the Gadget interface
• Power Controllers - Sensor+ racks, Sensor 3 racks
• Arch Controllers - Paradigm Architectural Control Processor (P-ACP)
• Network Routers - switches, routers and other non-configurable network infrastructure
devices.

• Software - ETC software, such as Gateway Configuration Editor, detected on the network.

Future compatibility is planned to include the following ETC products:

• Consoles - Eos and Congo family consoles
• Show Controllers - Eos RPU, Congo Light Server
• Accessories - Net3 RVI, Net3 RFR
• Gateways - addition of IO and Show Control Gateways
• Power Controllers - addition of Unison DRd dimming configuration, Echo Relay Panel
configuration, SmartBar 2 and SmartModule 2 configuration

See also Device Library and Discovered Devices for more information.

Device Firmware
Device firmware is the software component of a device package, located in the physical
hardware device. Device firmware is used by Net3 Concert to upgrade or downgrade the device.

See also Component Manager for more information.

Device Library
All device types which Concert can configure.

See also the topic Device Library for more information.

Device Package
A device package is the actual device definition and contains the information that Net3 Concert
needs to communicate with and configure a device, such as a list of preferred properties, etc.
Concert provides the flexibility to maintain multiple versions of device packages for the same
class of hardware, and allows integration of those multiple versions in the same configuration
through the Component Manager and Firmware Manager features.

Firmware
Many device packages include one or more firmware packages allowing users to upgrade or
downgrade the firmware in that device.

Firmware can be upgraded or downgraded from within the Net3 Concert application using the
Firmware Manager.

Installation
Device packages can be installed, removed and upgraded from within the Net3 Concert
application using the Component Manager.
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Preferred Properties
Each device package provides a list of its preferred properties (a subset of all its properties),
which are shown in the Spreadsheet view and Property Editor.

Note: Preferred properties concerning the IP addressing of the device, including IP
address, Subnet Mask, and Gateway, are not editable from the Property Editor while
in Live Edit.

Gadget Interface
Gadget is an ETC manufactured USB to DMX/RDM device which allows connection of RDM
devices directly to a PC. Gadget allows you the ability to work with stand-alone non-networked
RDM systems.

Reference RDM Device Configuration for more information.

Linked
Linked refers to the state of a device found "online" on the network having an association with
a device in the current configuration.

The association of a device in the Concert configuration with a physical device on the network is
called Linking. If a configuration is created using the "Network Map" feature, or by dragging
devices into the Workspace from Discovered Devices, the devices will be linked. If a
configuration is created using devices from the Device Library, which is a method typically done
when working offline from a networked system, when later connected to a network, you will
need to manually link to the physical network device using the "Link to Network Device"
feature.

Live Edit
Live Edit is an application mode in Concert that immediately applies changes to devices on the
network without the additional step of synchronizing. Place the configuration in Live Edit mode
by selecting the Live Edit icon on the toolbar or by selecting "Live Edit" from the File menu.
These functions toggle on and off.

When Concert is not in Live Edit mode, any changes to the configuration are retained in memory
and may be synchronized to the device at a later time, or saved as part of the configuration file.

Tip: When a configuration change has not been saved to the configuration file, an
asterisk displays in the configuration file name located at the top left of the application
window.

Note: Preferred properties concerning the IP addressing of the device, including IP
address, Subnet Mask, and Gateway, are not editable from the Property Editor while
in Live Edit.
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Logical System
A logical system is the user defined division, or grouping, of configured devices for the purpose
of management and viewing in configurations. See also Logical Systems in the Browser for
more information.

Net3 Conductor
Net3 Conductor Network Services Gateway is the Net3 device offered by ETC to store
configurations, logs, and network support files.

ODS
Open Document Spreadsheet file format. Open standard XML-based file format for representing
electronic documents. Use common spreadsheet software such as Microsoft Excel, etc. to open,
edit and review ODS documents.

See also Export ODS and Import ODS for more information.

RDM
ANSI E1.20 Remote Device Management over DMX512 networks.

Remote Device Management (RDM) is a protocol enhancement to USITT DMX512 that allows
bi-directional communication between a lighting or system controller and attached
RDM compliant devices over a standard DMX line. This protocol will allow configuration, status
monitoring, and management of these devices in such a way that does not disturb the normal
operation of standard DMX512 devices that do not recognize RDM protocol.

See also RDM Device Configuration.

sACN
ANSI E.31 Streaming DMX over ACN.

Lightweight streaming protocol for transport of DMX512 using ACN.

Sync Status
Net3 Concert maintains values for all of the device properties locally on the host computer.
When Concert is running and devices are present on the network, Concert compares its local
values with the properties of the linked device on the network. If the values of the device on the
network and the values in the Concert configuration differ, then the device will display a Sync
Status icon in red, meaning it is out of sync. To synchronize the network devices and the
Concert configuration, use the provided [Synchronize Configuration] button in the toolbar, or
select " Synchronize Configuration" from the Network menu.

System Layout
A system layout is the graphical or spreadsheet view, located in the workspace, of the
individual devices that make up a complete system.

World View
The world view is the default system layout, displayed either graphically or in a spreadsheet
view. This view contains all of the hardware devices that Net3 Concert has discovered and has
received configuration information.
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